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Product information
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IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Product description

Kit overview

Single-source
sample types
supported

About the primers

The Applied Biosystems ™ Yfiler" Plus PCR Amplification Kit is a 6-dye, short tandem
repeat (STR) multiplex assay optimized to allow amplification from multiple male-
specific sample types such as male-male, male-female mixtures. The kit amplifies 27
Y-STR loci, see Table 1.

The Yfiler " Plus PCR Amplification Kit uses the same improved process for synthesis
and purification of the amplification primers that are previously developed for other
next-generation Thermo Fisher Scientific STR chemistries. The improved amplification
primers deliver clean electrophoretic backgrounds that help interpretation.

The Yfiler” Plus PCR Amplification Kit is optimized to allow direct amplification
from the following types of single-source samples without the need for sample
purification:

* Blood and buccal samples on treated paper substrates.

* Blood samples collected on untreated paper substrates and treated with
Prep-n-Go " Buffer.

* Buccal samples collected on swab substrates and treated with Prep-n-Go " Buffer.

Non-nucleotide linkers are used in primer synthesis for the following loci: DYS389I/1I,
DYS635, DYS627, DYS19, YGATAH4, DYS448, DYS391, DYS390, DYS438, DYS391,
DYS390, DYS438, DYS392, DYS518, DYS437, and DYS449.

For these primers, non-nucleotide linkers are placed between the primers and the
fluorescent dye during oligonucleotide synthesis (Butler 2005, Grossman et al., 1994).
Non-nucleotide linkers enable reproducible positioning of the alleles to facilitate
interlocus spacing. The combination of a 6-dye fluorescent system and the use of non-
nucleotide linkers allows simultaneous amplification and efficient separation of the 27
Y-STR loci during automated DNA fragment analysis.

Yiler" Plus PCR Amplification Kit User Guide
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Dyes used in the

; Dye Color Label
kit -
6-FAM Blue Samples, allelic ladders, and controls

vic™ Green

NED"™ Yellow

TAZ" Red

SID™ Purple

Liz"™ Orange GeneScan"-600 LIZ™ Size Standard v2.0

Yiler" Plus PCR Amplification Kit User Guide
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Loci amplified by the kit
Table 1 Yfiler™ Plus PCR Amplification Kit loci and alleles

des"i;::;fion Alleles included in Allelic Ladder Dye label | DNA Control 007
DYS576 10,11, 12,13, 14, 15,16, 17, 18,19, 20, 21, 22, 23, 24, 25 6-FAM™ 19
DYS3891 9,10, 11,12, 13, 14, 15,16, 17 13
DYS635 15,16, 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30 24
DYS389lI 24,25, 26,27, 28, 29, 30, 31, 32, 33, 34, 35 29
DYS627 11,12,13, 14,15, 16,17, 18,19, 20, 21, 22, 23, 24, 25, 26, 27 21
DYS460 7,8,9,10,11,12,13, 14 vic™ 11
DYS458 11,12,13, 14,15, 16,17, 18,19, 20, 21, 22, 23, 24 17
DYS19 9,10, 11,12, 13, 14,15, 16,17, 18,19 15
YGATAH4 8,9,10,11,12,13, 14,15 13
DYS448 14,15,16,17,18,19, 20, 21, 22, 23, 24 19
DYS391 5,6,7,8910,11,12,13, 14,15, 16 11
DYS456 10,11, 12,13, 14, 15,16, 17, 18,19, 20, 21, 22, 23, 24 NED" 15
DYS390 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29 24
DYS438 6,7,8,9,10,11,12,13, 14,15, 16 12
DYS392 4,5,6,7,8,9,10,11,12,13, 14,15, 16,17, 18, 19, 20 13
DYS518 32,33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 4t 45, 46, 47, 48, 37

49
DYS570 10,11, 12,13, 14,15, 16, 17, 18,19, 20, 21, 22, 23, 24, 25, 26 TAZ" 17
DYS437 10,11, 12,13, 14, 15,16, 17,18 15
DYS385a/b  |6,7,8,9,10,11,12,13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 1,14
24,25, 26, 27, 28
DYS449 22,23, 24, 25, 26, 27, 28, 29, 30, 31, 32, 33, 34, 35, 36, 37, 38, 30
39, 40
DYS393 7,8,9,10,11,12,13, 14, 15,16, 17, 18 sip™ 13
DYS439 6,7,8,9,10,11,12,13, 14,15, 16, 17 12
DYS481 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 28, 29, 30, 31, 32 22
DYF38751 30, 31, 32, 33, 34, 35, 36, 37, 38, 39, 40, 41, 42, 43, 4t 35,37
DYS533 7,8,9,10,11,12,13, 14,15, 16, 17 13

10 Yfiler" Plus PCR Amplification Kit User Guide
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Standards and For the Yfiler ' Plus PCR Amplification Kit, the panel of standards needed for PCR
controls that are amplification, PCR product sizing, and genotyping are:
required

* DNA Control 007 — A positive control for evaluating the efficiency of the
amplification step and STR genotyping using the Yfiler " Plus Allelic Ladder.
DNA Control 007 is present in the kit. See “DNA Control 007 profile” on
page 12.

* GeneScan '-600 LIZ" Size Standard v2.0—Used for obtaining sizing results.
This standard, which has been evaluated as an internal size standard, yields

precise sizing results for PCR products. Order the GeneScan —600 LIZ" Size
Standard v2.0 (Cat. No. 4408399) separately.

* Yfiler" Plus Allelic Ladder—Developed for accurate characterization of the
alleles amplified by the kit. The Allelic Ladder is present in the kit and allows
automatic genotyping of most of the reported alleles for the loci in the kit. See
“Allelic ladder profile” on page 11.

Allelic ladder profile
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Figure 1 GeneMapper " /D-X Software plot of the Yfiler" Plus Allelic Ladder (Y-axis scale 0 to 6,000 RFU).
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DNA Control 007 profile
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Figure 2 DNA Control 007 (1 ng) amplified with the Yfiler" Plus PCR Amplification Kit and analyzed on an Applied
Biosystems " 3500xL Genetic Analyzer (Y-axis scale 0 to 12,000 RFU).
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Contents and storage

The Yfiler Plus PCR Amplification Kit contains sufficient quantities of the following
reagents to perform: 100 (Cat. No. 4484678) or 500 (Cat. No. 4482730) amplifications at

25 puL/amplification.

Note: If there is more than one tube or bottle for a single reagent, thaw only the
number of tubes or bottles required for the current number of reactions.

IMPORTANT! The fluorescent dyes that are attached to the primers are light-
sensitive. Protect the primer set, amplified DNA, allelic ladder, and size standard
from light when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

Table 2 Yfiler" Plus PCR Amplification Kit

Contents

100 reactions
(Cat. No. 4484678)

500 reactions
(Cat. No. 4482730)

Storage

Yfiler™ Plus Master Mix 2x0.5mL 4x1.25mL -25°C to -15°C on
Contains MgCly, dATP, dGTP, dCTP, and receipt.

dTTP, bovine serum albumin, enzyme, and 2°C to 8°C after first
0.05% sodium azide in buffer and salt. use.

Yfiler™ Plus Primer Set 2x0.25mL 2x1.25mL -25°C to -15°C on

Contains locus-specific 6—FAMTM, VICTM,
NED"™, TAZ", and SID™ dye-labeled and
unlabeled primers in buffer. The primers
amplify the Y-STR loci DYS19, DYS385 a/b,
DYF387S1 a/b, DYS389 I/1l, DYS390, DYS391,
DYS392, DYS393, DYS437, DYS438, DYS439,
DYS448, DYS449, DYS456, DYS458, DYS460,
DYS481, DYS518, DYS533, DYS570, DYS576,

DYS627, DYS635 (Y GATA C4), and Y GATA Ha.

receipt.

2°C to 8°C after first
use.

Store protected from
light.

Yiler" Plus PCR Amplification Kit User Guide
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Contents

100 reactions
(Cat. No. 4484678)

500 reactions
(Cat. No. 4482730)

Storage

Contains 2 ng/pL of human male genomic
DNA in 0.05% sodium azide and buffer.

Yfiler™ Plus Allelic Ladder 2 x 0.025 mL 2 x 0.05 mL -25°C to -15°C on
Contains the following amplified alleles: receipt.
e 6-FAM™ dye (blue): DYS3891 9-17; 2°C to 8°C after first
DYS38911 24-35; DYS576 10-25; DYS627 use.
11-27; DYS635 15-30. Store protected from
o VIC" dye (green): DYS19 10-19; DYS391 light.
5-16; DYS448 14-24; DYSL58 11-24;
DYS460 7-14; Y GATA H4 8-15. IMPORTANT! The
« NED" dye (yellow): DYS390 17-29; allelic ladder
DYS392 4-20; DYS438 6-16; DYS456 10— contains PCR
24: DYS518 32-49. products. Do not
o amplify. To avoid
o TAZ" dye (red): DYS385 a/b 32-49; contamination, store
DYS437 10-18; DYS449 22-40; the allelic ladder
DYS570 10-26. separate from the
o SID" dye (purple): DYF38751 a/b 30-44; other kit components
DYS393 7-18; DYS439 6-17; DYS481 17- and unamplified DNA.
32; DYS533 7-17.
DNA Control 007 1x0.05 mL 2 x 0.05 mL -25°C to -15°C on

receipt.

2°C to 8°C after first
use.

Required materials not supplied

14

See Appendix C, “Materials required but not supplied”.
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Instrument
type

Validated models

Thermal
cyclers

o ProFlex" 96-well PCR System (Cat. No. 4484075)

o ProFlex" 3 x 32-Well PCR System (Cat. No. 4484073)

o Veriti" 96-Well Thermal Cycler (Cat. No. 4479071)

o GeneAmp' PCR System 9700, 96-Well Silver (Cat. No. N8050001)

o GeneAmp" PCR System 9700, 96-Well Gold-Plated (Cat. No. 4314878)

IMPORTANT! The Yfiler™ Plus kit is NOT validated for use with:

+ ProFlex" 2 x Flat PCR System (Cat. No. 4484078)

+ ProFlex" 2 x 384-well PCR System (Cat. No. 4484077)

- Veriti" 96-Well Fast Thermal Cycler (Cat. No. 4375305)

+ GeneAmp" PCR System 9700 with the aluminium 96-well block (Cat. No. 4314879)

Genetic
analyzers!"

e 3500/3500xL Genetic Analyzer with any of the following:

- 3500 Data Collection Software v1 (Windows" Vista operating system) and HID Updater
3500 Data Collection Software v2 (Cat. No. 4480670)

- 3500 Data Collection v2 Software (Windows™ 7 operating system) and HID Updater 3500
Data Collection Software v2 (Cat. No. 4480670)

- 3500 Data Collection v3 Software (Windows" 7 operating system)

e 3130/3130x(/Genetic Analyzer with:
- Data Collection Software v4 (Windows™ 7 operating system)

- 3130/3730 Data Collection v4 6-Dye Module v1

Analysis
software

GeneMapper" /D-XSoftware v1.4 or later

Windows ™ XP or Windows " 7 operating system

(1 We conducted validation studies using the 3130, 3500, and 3500xL configurations.

Yfiler" Plus PCR Amplification Kit User Guide
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Process casewgﬂrk (extracted DNA) samples with the Process database (direct amplification) samples with
Yfiler  Plus PCR Amplification Kit the Yfiler" Plus PCR Amplification Kit

. - _ “Direct amplification: Treated and untreated paper
Extracted DNA: Prepare the amplification kit substrates” on page 22 or
reactions” on page 19 L o )
Direct amplification: Swab substrates™ on page 24
v v

“Perform PCR" on page 28

For compatible thermal cyclers, see “Instruments and software compatibility” on page 15
v

Perform electrophoresis
“Set up the 3500/3500xL instruments for electrophoresis (before first use of the kit)” on page 30 or

“Set up the 3130/3130xl instruments for electrophoresis (before first use of the kit]” on page 35 or
v
“Prepare samples for electrophoresis (3500 Series and 3130 Series instruments)” on page 34
v

Analyze data
“Set up the GeneMapper"™ ID-X Software for analysis (before first use of the kit)” on page 41

v
“Create an analysis method” on page 46
v
“Create a size standard definition file if needed” on page 54
v
“Analyze and edit sample files with GeneMapper™ ID-X Software” on page 56
v

“Examine or edit a project” on page 57

16 Yfiler" Plus PCR Amplification Kit User Guide
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Perform PCR

Extracted DNA: DNA quantification .................................... 17
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Direct amplification: Optimize PCR cyclenumber ........................ 21
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Direct amplification: Swab substrates .................. ... ... .. .. 24
Perform PCR . ... 28

Extracted DNA: DNA quantification

Importance of
quantification
before STR
analysis

DNA quantification can be used to determine:

If the sample contains sufficient human DNA and/or human male DNA to
proceed with short tandem repeat (STR) analysis.

The amount of sample to use in STR analysis applications.

For the Quantifiler” Trio DNA Quantification Kit, the relative quantities of
human male and female DNA in a sample that can help in the selection of the
appropriate STR chemistry.

The DNA quality, regarding inhibition level (all kits) or the inhibition level and
the DNA degradation level (Quantifiler " HP DNA Quantification Kit and
Quantifiler” Trio DNA Quantification Kit only). This metric is useful for
determining the likelihood of recovery of STR loci with larger amplicon sizes.

Highly degraded samples that cannot be recovered by STR analysis with
capillary electrophoresis can be analyzed with the Precision ID NGS System and
Panels. Optimized for degraded samples, the Precision ID Identity Panel provides
discrimination of individuals similar to STR genotype match probabilities. Also,
the Precision ID Ancestry Panel infers biogeographical ancestry for investigative
leads.

If PCR inhibitors are present in a sample that may require additional purification
before proceeding to STR analysis.

Effect of DNA If too much DNA is added to the PCR reaction, the increased amount of PCR product
quantity on results that is generated can result in:

Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).

Yiler" Plus PCR Amplification Kit User Guide 17
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Off-scale data is a problem because:

- Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated

percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.

To address these issues, reamplify the sample using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added
to the PCR is extremely low and unbalanced amplification of the alleles may occur
because of stochastic fluctuation.

Methods of For information on recent innovations in quantification chemistry, go to
quantifying DNA thermofisher.com.
Kit and user guide Detects How it works

Quantifiler" Human DNA
Quantification Kit
(Cat. No. 4343895)

For more information, see
Quantifiler” Human DNA
Quantification Kit and Y
Human Male DNA
Quantification Kit User Guide
(Pub. No. 4344790

e Total human
DNA

Uses a target-specific 5’ nuclease assay:
e Two locus-specific PCR primers
e One TagMan® MGB probe labeled with FAM™ dye for
detecting the target sequence
Uses an Internal PCR control (IPC) 5’ nuclease assay:

¢ |PC template DNA (a synthetic sequence not found in
nature)
e Two primers for amplifying the IPC template

e One TagMan® MGB probe labeled with VIC™ dye for
detecting the IPC target

Quantifiler" Duo DNA
Quantification Kit
(Cat. No. 4387746)

For more information, see
Quantifiler” Duo DNA
Quantification Kit User Guide
(Pub. No. 4391294)

e Total human
DNA

¢ Human male
DNA

Uses two target-specific 5’ nuclease assays:
¢ Two locus-specific PCR primers per target (one for total
human DNA and one for human male DNA]

o Two TagMan® MGB probes labeled with VIC™ dye (for
total human DNAJ and FAM™ dye (for human male DNA)
for detecting the target sequences

Uses an Internal PCR control (IPC) 5’ nuclease assay:

* IPC template DNA (a synthetic sequence not found in
nature)
e Two primers for amplifying the IPC template

e One TagMan® MGB probe labeled with NED™ dye for
detecting the IPC target

18
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Quantifiler" Trio DNA
Quantification Kits User Guide
(Pub. No. 4485354)

Kit and user guide Detects How it works
Quantifiler™ HP DNA e Total human e Uses 5 nuclease assays with multiple-copy target loci,
Quantification Kit (Cat. No. DNA (two targets for improved detection sensitivity:[!]
4482911) —one small - The human-specific target loci are multiple copy,
. . amplicon and and dispersed on various autosomal chromosomes.

For more information, see one lar

L ger . e .
Quantifiler HP and amplicon) - The primary quantification targets have relatively

short amplicons (75 to 80 bases), to improve the
Degraded DNA detection of degraded DNA samples.

e Uses features that maximize consistency of

Quantifiler™ Trio DNA
Quantification Kit (Cat. No.
4482910)

For more information, see
Quantifiler” HP and
Quantifiler” Trio DNA
Quantification Kits User Guide
(Pub. No. 4485354)

Total human quantification:

DNA (two targets - Genomi; ta.rgets. have conserved primer- and
—one small probe-binding sites.

amplicon and - Minimal copy number variation between different
one larger individuals and population groups.

amplicon) » Contains a Large Autosomal target with a longer
Human male amplicon (>200 bases) to help determine if a DNA
DNA sample is degraded.

Degraded DNA

[ The detection sensitivity of the Quantifiler™ HP Kit and the Quantifiler™ Trio Kit is improved over the Quantifiler™ Duo Kit.

Extracted DNA: Before you begin

Thaw reagents
(before first use of

Thaw the Master Mix and Primer Set.

the kit) IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2°C to 8°C and do not require subsequent thawing. Do not
refreeze the reagents.

Extracted DNA: Prepare the amplification kit reactions

Prepare low-TE For optimal results, we recommend using low-TE buffer for sample preparation.
buffer Prepare it as described in this procedure or buy it from Teknova (Cat. No. T0223).
1. Mix together:

10 mL of 1 M Tris-HCl, pH 8.0
0.2 mL of 0.5 M EDTA, pH 8.0

990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.

Yfiler" Plus PCR Amplification Kit User Guide 19
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Extracted DNA: Prepare the amplification kit reactions

2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

Prepare the

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect

amplification kit the primer set, amplified DNA, allelic ladder, and size standard from light when not
reactions: in use.

extracted DNA

20

. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or

bottles, remove droplets from the caps by centrifuging the tubes briefly or
tapping the bottles on the bench.

Pipette the required volumes of components into an appropriately sized clear
(non-colored) polypropylene tube:

Reaction component Volume per reaction

Master Mix 10.0 pL

Primer Set 5.0pL

Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.

Vortex the reaction mixture for 3 seconds, then centrifuge briefly.

Dispense 15 uL of reaction mixture into each reaction well of a MicroAmp"™
Optical 96-Well Reaction Plate or each MicroAmp'" tube.

Prepare samples as shown in the following table, then add them to the
appropriate well or tube (final reaction volume is 25 pL).

Sample 30-cycle protocol
Negative control Add 10 pL of low-TE buffer.

Test sample Add test DNA sample to a total amount of
1.0 ng.

Positive control Add 007 control DNA to a total amount of 1.0 ng.

Note: 007 control DNA contains 2 ng/uL of
human male genomic DNA.

Seal the MicroAmp " Optical 96-Well Reaction Plate with MicroAmp " Clear
Adhesive Film or MicroAmp" Optical Adhesive Film, or cap the tubes.

Centrifuge the tubes or plate at 3,000 rpm for about 20 seconds in a tabletop
centrifuge (with plate holders, if using 96-well plates).

Amplify the samples as described in Chapter 2, “Perform PCR".

IMPORTANT! This kit is not validated for use with the GeneAmp " PCR System
9700 with the aluminum 96-well block. Use of this thermal cycling platform may
adversely affect performance of this kit.

Yiler" Plus PCR Amplification Kit User Guide
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Direct amplification: Optimize PCR cycle number

Direct amplification: Optimize PCR cycle number

Procedural
guidelines:
Optimize PCR
cycle number

Select samples
and prepare
plates

Determine
optimum PCR
conditions

Before using the Yfiler" Plus PCR Amplification Kit for the first time, perform a single
initial sensitivity experiment. The experiment determines the appropriate cycle
number to use during internal validation studies and operational use of the kit. It also
accounts for instrument-to-instrument and sample-to-sample variations. If you are
processing multiple sample type and substrate combinations (for example, buccal
samples on treated paper and buccal samples on swabs), perform separate sensitivity
experiments for each sample type and substrate to be used for testing.

* Select 26 samples so that you can complete electrophoresis using a single 96-well
plate. This minimizes the impact of run-to-run variation on the results. Examples
of PCR and electrophoresis plate layouts are provided on page 117.

* To maximize result quality, prepare and amplify Plate 1, then repeat for Plates 2
and 3. Do not prepare all 3 plates before amplification.

e To minimize the effect of instrument-to-instrument variation, use the same
thermal cycler to amplify all 3 plates.

1. Select 26 of each sample+substrate type. Ensure that the selected samples
represent a "typical” range of samples analyzed in your laboratory.

2. Prepare the samples and the reactions as described in the appropriate protocols
later in this chapter. To complete amplification of three replicate plates, prepare
sufficient PCR reagents.

3. Create the first of 3 identical PCR plates, see Appendix D, “Plate layouts”.

4. Amplify each plate using a different cycle number to determine the optimum
conditions for use in your laboratory.

Suggested cycle numbers for different sample type and substrate combinations
are listed in the following table.

Substrate
Sample type
Treated or untreated paper
Blood 27, 28, 29 cycles
Buccal 27, 28, 29 cycles

Note: To minimize the effect of instrument-to-instrument variation, use the same
thermal cycler to amplify all three plates. To maximize result quality, prepare and
amplify Plate 1 then repeat for Plates 2 and 3. Do not prepare all three plates
simultaneously.

If the average peak heights fall outside of the range of values that are listed
below, test higher or lower cycle numbers to attain optimal peak heights.

1. Run the PCR products on the appropriate CE platform using the recommended
protocol that is described in Chapter 3, “Perform electrophoresis”.

2. Based on the results of the sensitivity study, select the appropriate PCR cycle
number for future experiments.

Yfiler" Plus PCR Amplification Kit User Guide 21



T
548

Ny

-
]

%

2 Chapter 2 Perform PCR
| Direct amplification: Before you begin

Our studies indicate the optimum PCR cycle number generates profiles with the
following heterozygote peak heights, with no instances of allelic dropout and minimal
occurrence of off-scale allele peaks:

Instrument Heterozygous peak height
3500 Series 5,000-12,000 RFU
31xx 2,500-4,000 RFU

When amplifying single-source, unpurified samples, greater sample-to-sample
variation in peak height can be observed than with purified samples. Careful
optimization of the cycle number helps to minimize this variation.

Direct amplification: Before you begin

Thaw reagents
(before first use of
the kit)

Thaw the Master Mix and Primer Set.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2°C to 8°C and do not require subsequent thawing. Do not
refreeze the reagents.

Direct amplification: Treated and untreated paper substrates

Sample
preparation
guidelines:
treated or
untreated paper
substrate

Prepare low-TE
buffer

22

* Do not add water to the wells on the reaction plate before adding the punches. If
you observe static issues with the paper discs, you can prepare and dispense the
25-puL reaction mix into the wells of the reaction plate before adding the punches.

¢ To ensure optimum peak intensity, make the punch as close as possible to the
center of the sample. Increasing the size of the punch can cause inhibition during
PCR amplification.

¢ For manual punching: Place the tip of a 1.2 mm Harris Micro-Punch on the card,
hold the barrel of the Harris Micro-Punch (do not touch the plunger), gently
press and twist 1/4-turn, then eject the punch in to the appropriate well on the
reaction plate.

¢ For automated punching: See the User Guide of your automated or
semiautomated disc punch instrument for proper guidance.

* For blood on untreated paper samples, add 2 uL of Prep-n-Go " Buffer (for use
with untreated paper substrates) on top of the 1.2-mm sample punch.

For optimal results, we recommend using low-TE buffer for sample preparation.
Prepare it as described in this procedure or buy it from Teknova (Cat. No. T0223).

Yiler" Plus PCR Amplification Kit User Guide
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Direct amplification: Treated and untreated paper substrates
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1. Mix together:
e 10 mL of 1 M Tris-HCl, pH 8.0
e 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

Prepe_lre the IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
reactions: treated  the primer set, amplified DNA, allelic ladder, and size standard from light when not

or untreated in use.
paper substrates

If this is the first time you are using the kit, follow the instructions in “Thaw reagents
(before first use of the kit)” on page 19 before proceeding.

1. Add samples to the reaction plate:

To these wells ... Add...

Negative control 1.2 mm blank disc

Test samples 1.2 mm sample disc

Positive control For 26 cycles 3 pL of Control DNA 007

IMPORTANT! Do not add a For 27 cycles 2 uL of Control DNA 007

blank disc to the positive control

well. For 28 cycles 1 uL of Control DNA 007
For 29 cycles 1 pL of Control DNA 007

Note: If the peak heights are too high or too low for your optimized cycle
number, the suggested volumes of positive control can be adjusted.

2. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or
bottles, remove droplets from the caps by centrifuging the tubes briefly or
tapping the bottles on the bench.

3. Pipet the required volumes of components into an appropriately sized

polypropylene tube.
Reaction component Volume per reaction
Master Mix 10.0 pL
Primer Set 50 L
Low TE buffer 10.0 L

Yfiler" Plus PCR Amplification Kit User Guide 23
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Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! This kit is optimized for a 25-uL PCR volume to overcome the
PCR inhibition that is expected when amplifying unpurified samples. Using a
lower PCR reaction volume may reduce the ability of the kit chemistry to
generate full STR profiles.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 25 uL of the reaction mix into each reaction well of a MicroAmp"™
Optical 96-Well Reaction Plate.

6. Seal the plate with MicroAmp " Clear Adhesive Film (Cat. No. 4306311) or
MicroAmp"" Optical Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a
consistent seal across all wells and prevent evaporation. Do not use caps, which
may not provide a consistent seal across all wells.

IMPORTANT! If you are using the GeneAmp"" PCR System 9700 with silver or

gold-plated silver block and adhesive clear film instead of caps to seal the plate
wells, place a MicroAmp " Optical Film Compression Pad (Cat. No. 4312639) on
top of the plate to prevent evaporation during thermal cycling. Other validated

thermal cyclers do not require a compression pad.

7. Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

8. Amplify the samples as described in Chapter 2, “Perform PCR”.

IMPORTANT! This kit is not validated for use with the GeneAmp " PCR System
9700 with the aluminum 96-well block. Use of this thermal cycling platform may
adversely affect performance of this kit.

Direct amplification: Swab substrates

Sample * Detach each buccal swab head from the swab shaft before lysis.

preparation * If you are using the heated lysis protocol, perform lysis in either of the following

guidelines: swab formats:

substrate — 1.5-mL tubes with a heat block (VWR"™ Scientific Select dry heat block or
similar)

— PrepFiler” 96-Well Processing Plates (Cat. No. 4392904)

™

— Robbins Scientific* Model 400 Hybridization Incubator or similar

— Agilent” Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or similar
(Cat. No. 410094)

IMPORTANT! Do not use a plastic plate adaptor.

¢ For optimum performance, lyse the entire swab. If you need to preserve the
sample, use half of the lysate prepared from the entire swab.

24 Yfiler" Plus PCR Amplification Kit User Guide
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Prepare the This protocol may improve the performance for challenging or aged samples.

sample lysate: 1
room temperature

. Add 400 uL Prep-n-Go'" Buffer (Cat. No. 4471406) to 1.5-mL tubes or the

appropriate wells of a PrepFiler " 96-Well Processing Plate (Cat. No. 4392904).

Into each tube or well, put the entire head of each swab, then let stand for
20 minutes at room temperature (20°C to 25°C) to lyse the sample.

After 20 minutes, transfer the sample lysate out of the sample plate into tubes or
plates for storage, then discard the deep-well plate containing the swab heads.
Note: To minimize the risk of contamination, do not remove the swab heads

from the sample lysate plate before transferring the lysate.

Go to “Prepare the reactions: swab substrate” on page 26 or “Store the sample
lysate” on page 27.

Prepare the This protocol may improve the performance for challenging or aged samples.

sample lysate: 1
heat protocol

2.

. Preheat the heat block to 90°C or the oven with metal plate adaptor to 99°C.

Add 400 L Prep-n-Go™ Buffer (for buccal swabs, Cat. No. 4471406) to 1.5-mL
tubes or the appropriate wells of a PrepFiler 96-Well Processing Plate
(Cat. No. 4392904).

Into each tube or well, put the entire head of each swab. If you are using tubes,
cap the tubes. Let the tubes or plate stand for 20 minutes in the preheated heat
block or oven to lyse the sample.

After 20 minutes, remove the tubes or the deep-well plate from the heat block or
oven.

Let the lysate stand at room temperature for at least 15 minutes to cool the lysate
(for accurate pipetting).

Transfer the sample lysate out of the 1.5-mL tubes or sample plate into tubes or
plates for storage. Discard the 1.5-mL tubes or deep-well plate containing the
swab heads.

Note: To minimize the risk of contamination, do not remove the swab heads

from the sample lysate plate before transferring the lysate.

Go to “Prepare the reactions: swab substrate” on page 26 or “Store the sample
lysate” on page 27.
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Prepe_are the IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
reactions: swab the primer set, amplified DNA, allelic ladder, and size standard from light when not
substrate in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents
(before first use of the kit)"” on page 19 before proceeding.

1. Add Prep-n-Go " Buffer (Cat. No. 4471406) to the control wells in the
MicroAmp " Optical 96-Well Reaction Plate:

To these wells ... Add...
Negative control 3 pL of Prep-n-Go™ Buffer
Positive control For 26 cycles 0 pL of Prep-n-Go™ Buffer
For 27 cycles 1 uL of Prep-n-Go " Buffer
For 28 and 2 L of Prep-n-Go™ Buffer
29 cycles

2. Vortex the Master Mix and Primer Set for 3 seconds. Before opening the tubes or
bottles, remove droplets from the caps by centrifuging the tubes briefly or
tapping the bottles on the bench.

3. Pipet the required volumes of components into an appropriately sized

polypropylene tube.
Reaction component Volume per reaction
Master Mix 10.0 L
Primer Set 5.0 uL
Low TE buffer 10.0 L

Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! This kit is optimized for a 25-uL PCR volume to overcome the
PCR inhibition that is expected when amplifying unpurified samples. Using a
lower PCR reaction volume may reduce the ability of the kit chemistry to
generate full STR profiles.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 25 uL of the reaction mix into each reaction well of a MicroAmp
Optical 96-Well Reaction Plate.

The final volume in each well is 28 uL (reaction mix plus Prep-n-Go'" Buffer or
sample lysate or positive control).

26 Yfiler" Plus PCR Amplification Kit User Guide
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Add samples to the reaction plate:

To these well(s) of a MicroAmp"™ Add
Optical 96-Well Reaction Plate...
Test samples 3 pL of sample lysate
Positive control For 26 cycles 3 pL of Control
DNA 007
For 27 cycles 2 pL of Control
DNA 007
For 28 and 29 cycles 1 pL of Control
DNA 007

Note: If peak heights are too high or too low for your optimized cycle number,
the suggested volumes of positive control can be adjusted.

™

Seal the plate with MicroAmp = Clear Adhesive Film (Cat. No. 4306311) or
MicroAmp " Optical Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a
consistent seal across all wells and prevent evaporation. Do not use caps, which
may not provide a consistent seal across all wells.

IMPORTANT! If you are using the GeneAmp " PCR System 9700 with silver or

gold-plated silver block and adhesive clear film instead of caps to seal the plate
wells, place a MicroAmp ' Optical Film Compression Pad (Cat. No. 4312639) on
top of the plate to prevent evaporation during thermal cycling. Other validated

thermal cyclers do not require a compression pad.

Vortex the reaction mix at medium speed for 3 seconds.

Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

Amplify the samples as described in Chapter 2, “Perform PCR".

IMPORTANT! This kit is not validated for use with the GeneAmp " PCR System
9700 with the aluminum 96-well block. Use of this thermal cycling platform may
adversely affect performance of this kit.

. Cap the sample lysate storage tubes or seal the sample lysate storage plate with

MicroAmp " Clear Adhesive Film.

Store the sample lysate as needed:

If you are storing the sample lysate... Then place at...
<2 weeks 2°C to 8°C
>2 weeks -25°C to -15°C

Note: The effects of multiple freeze/thaw cycles on the lysate have not been fully
evaluated. Therefore, multiple freeze/thaw cycles are not recommended.

Yfiler" Plus PCR Amplification Kit User Guide 27
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Perform PCR

28

IMPORTANT! This kit is validated for use with the thermal cyclers listed in

“Instruments and software compatibility” on page 15 .

1. Program the thermal cycling conditions.

IMPORTANT!

. If you are using the ProFlex”" 96-well PCR System, then run in the GeneAmp""

PCR System 9600 Simulation Mode.

For instructions on how to configure the ProFlex"" 96-well PCR System to run
GeneAmp'" PCR System 9600 Simulation Mode, see the ProFlex” PCR System
User Guide (Cat. No. MANO0007697).

. If you are using the GeneAmp ' PCR System 9700 with a 96-well silver or

gold-plated silver block, then select 9600 Emulation Mode.

For instructions on how to configure the GeneAmp' PCR System 9700 to run
9600 Emulation Mode, see the GeneAmp" PCR System 9700 Base Module User
Manual (Cat. No. 4303481).

. If you are using the Veriti ' 96-Well Thermal Cycler, then select 9600

Emulation Mode.
For instructions on how to configure the Veriti* 96-Well Thermal Cycler to run

9600 Emulation Mode, see the Veriti" 96-Well Thermal Cycler AmpF(STR™ Kit
Validation User Bulletin (Cat. No. 4440754).
Initial Optimum cycle number!! .
. . Final .
incubation - Final hold
step Denature | Anneal/Extend | ©Xtension
HOLD CYCLE HOLD HOLD
(Direct Amplification 26-29)
(Extracted DNA 30)
95°C, 94°C, 61.5°C, 60°C, 4°C,
1 minute 4 seconds 1 minute 22 minutes up to 24 hours!?

1" See “Direct amplification: Optimize PCR cycle number” on page 21.
21" The infinity (o) setting allows an unlimited hold time.

. Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using adhesive clear film instead of caps to seal the
plate wells, be sure to place a MicroAmp " Optical Film Compression Pad
(Cat. No. 4312639) on top of the plate to prevent evaporation during thermal
cycling. The Veriti ' Thermal Cycler does not require a compression pad.

. When the run is complete, store the amplified DNA.

If you are storing the DNA... Then place at...
<2 weeks 2°C to 8°C
>2 weeks -25°C to -15°C

IMPORTANT! Protect the amplified DNA from
light.

Yiler" Plus PCR Amplification Kit User Guide
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Allelic ladder requirements for electrophoresis ........................... 29

Materials required for electrophoresis ..................... ... ... ... ... 30

Set up the 3500/3500xL instruments for electrophoresis (before first use

of the Kit) .. ... o 30
B Prepare samples for electrophoresis (3500 Series and 3130

Series INStruUmMents) . ... ..ottt e 34
B Set up the 3130/3130xI instruments for electrophoresis (before first use

of the Kit) .. ... 35
B Prepare samples for electrophoresis (3500 Series and 3130

Series INStruUmMEents) . ... ...ttt e 37

Allelic ladder requirements for electrophoresis

To accurately genotype samples, you must run an allelic ladder with the samples.

Number of One .
. s Number of samples per allelic
Instrument allelic ladders injection
ladder(s)
to run equals
3500 1 per 3 injections | 8 samples 23 samples + 1 allelic ladder
3500x/ 1 perinjection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 injections | 4 samples 15 samples + 1 allelic ladder
3130x/ 1 perinjection 16 samples 15 samples + 1 allelic ladder

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between runs. Follow the guidelines in the
preceding table, which should account for normal variation in run speed. Perform
internal validation studies to verify the required allelic ladder injection frequency, to
ensure accurate genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples. Size values obtained for the same sample can differ between instrument
platforms, because of different polymer matrices and electrophoretic conditions.
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S’ Materials required for electrophoresis

Materials required for electrophoresis

Appendix C, “Materials required but not supplied” lists the required materials that
are not supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive. Protect
the primer set, amplified DNA, allelic ladder, and size standard from light when not
in use.

Set up the 3500/3500xL instruments for electrophoresis (before first
use of the kit)

Electrophoresis
software setup

The following table lists the data collection software and the run modules that you
can use to analyze PCR products generated by this kit. For details on the procedures,

see the documents listed in “Documentation and support” on page 123.

Note: We conducted validation studies for the kit using the 3130xI, 3500, or 3500xL

configurations.
Genetic Operatin 2EIE Plate templates, assays, run modules, and
P 9 Collection Additional software > temp ates, yS, ’
Analyzer System conditions (installed with the HID Updater)
Software
3500 Windows™ 3500 Data HID Updater 3500 | Plate templates: édye_36_POP4 (and _xl)
3500xL Vista Collection DCv2
Software v2 (Cat. No. 4480670) |Assays: GF+Norm_POP4 (and _xl) and
GF_POP4 (and _xl), which contain instrument
protocol HID36_POP4 (and_xl)_J6_NT3200
with the following conditions:
e Run module: HID36_POP4 (and _xl)
* Injection conditions: 1.2 kV/16 sec (24 sec
for xt!]
¢ Alternate injection conditions: 1.5 kV/16
sec (24 sec for x|){2]
e Run conditions: 13 kV/1550 sec
e Dye Set J6
3500 Windows " 7 3500 Data HID Updater 3500 |Same as 3500 Data Collection Software v2
3500xL Collection DCv2 listed above
Software v2 (Cat. No. 4480670)
3500 Windows™ 7 3500 Data None Same as 3500 Data Collection Software v2
Collection listed above
3500xL Software v3

01 This kit was developed using an injection time of 16 seconds on the 3500 instrument. This is different than the default injection time of
15 seconds. The instrument protocol will need to be modified accordingly.

21 This kit was developed using two injection voltage conditions for the 3500 instrument; 1.2 kV/16 sec and 1.5 kV/16 sec. You are encouraged to
explore both options during validation to determine which protocol provides the best results on your instrumentation.

30
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Obtain and run the Perform this procedure if you are using 3500 Series Software v1 or v2.

HID Updater (v1 You can run 6-dye samples on 3500 Data Collection Software. Before running on
and v2 software either system for the first time, run the HID Updater 3500 DC v2 (Cat. No. 4480670).
only) The HID Updater installs plate templates, assays, and instrument protocols that can

be used to run Yfiler  Plus PCR Amplification Kit samples. For more information,
refer to the release notes provided with the Updater.

Note: If you have a new instrument installed by a Thermo Fisher Scientific
representative, the updater may have been run during installation.

1. Shut down the 3500/3500xL Data Collection Software.

2. Download the updater from www.thermofisher.com/us/en/home/
technical-resources/software-downloads/
3500-Series-Genetic-Analyzers-for-Human-Identification.html.

3. Open the Read me file and review the software release notes.
4. Click the updater .exe file.
5. Follow the on-screen prompts.

6. Restart the computer.

Create a Yfiler" The Yfiler  Plus assay has an instrument protocol and a QC protocol. The easiest way
Plus assay to create an assay is to start off with an existing one that can be modified
independently. To modify an existing assay:

1. Access the Assays library by selecting the Library tab and then the Assays tab
under Library Resources.

2. Select an existing assay (for example, GF_POP4), click Duplicate then give it a
new name (for example, YFP_POP4).

3. Select the new assay, then click Edit to open it.

4. Open the instrument protocol by clicking Edit, then modify the injection and run
conditions specific to your instrument class and as shown in “Electrophoresis
software setup” on page 30. Save the modified instrument protocol by clicking
Save to Library, then give the protocol a new name.

5. To edit the QC protocol, follow the instructions.

Modify 3500 QC The Yfiler " Plus PCR Amplification Kit has been validated with data that was
protocol analyzed using both the 3rd Order Least Squares method (80-460 base pairs) and
Local Southern method (60460 base pairs).

Before using the QC protocol to acquire data, modify it to:

¢ Change the Baseline Window and Peak Window Settings default settings to the
settings shown in the following figure.

* Change the size calling default setting to to Local Southern, if needed.
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1. In the Library tab, open the QC Protocol window.

2. Create a new QC protocol:

a. Name the new QC protocol according to your laboratory naming
convention.

b. Set the following parameters:

Parameter Setting
Size Standard GS600_LIZ_(60-460)
Size Range Partial
Sizing Start Size 60 bp
Sizing Stop Size 460 bp
Size Calling Method Local Southern Method or 3rd Order

Least Squares

After checking the "Use Baselining” 33
box: Baseline Window Pts.

Peak Window Size 13
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c. Click Save.

3

Setup a OC Protocol

* Protocol Name —

Description:

Size Standard: | GSG00_LIZ (50-460) v <«
Sizecaller (SzeCallervl10 ~

Analysis Settings | QC Settings

Commen Settings

i Analysis Range: Sizing Range: Partial ~| €—
Analysis Start Point: | 0 Sizing Start Sizex 60 “— T
Analysis Stop Point: | 1000000 Sizing Stop Size 460 a—
|| Blue 7] Green [ Yellow [J] Red '/ Purple Orange
Peak Amplitude Threshold 175 175 175 175 175 175

Use Smeothing [i_|_’;||; - I

Use Baselining {Baseline Window (Pts)) | [¥] 33 <
Minimum Peak Half Width | 2 I
Paak Window Size | 12 I L ]
Palynomial Degree 3—
Slope Thresheld Peak Start 00
Slope Threshold Peak End 0p

|

U Locked

Size Calling Method: | Local Southermn '|

3. Add the QC protocol to the HID assay.

Yfiler" Plus PCR Amplification Kit User Guide
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Perform spectral Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)

The following figure is an example of a passing 6-dye spectral calibration.

EEREEER

M EREERERERAD

Intarmity s Scan Humbar

EENEEER

Inbansityva Pl Hummbar

Prepare samples for electrophoresis (3500 Series and 3130 Series
instruments)

This procedure applies to the 3500 Series and 3130 Series instruments.

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized

polypropylene tube:
Reagent Volume per reaction
GeneScan-600 LIZ"™ Size Standard v2.0 0.4 pL
Hi-Di" Formamide 9.6 L

Note: Include volume for additional samples to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Vortex the tube, then briefly centrifuge.

3. Into each well of a MicroAmp'" Optical 96-Well Reaction Plate, add:
* 10 pL of the formamide/size standard mixture
¢ 1 uL of PCR product or Allelic Ladder

Note: For blank wells, add 10 pL of Hi-Di" Formamide.
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4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.
6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.

Set up the 3130/3130x/ instruments for electrophoresis (before first
use of the kit)

Electrophoresis The following table lists the data collection software and the run modules that you
software setup can use to analyze PCR products generated by this kit. For details on the procedures,
see the documents listed in “Documentation and support” on page 123.

Note: We conducted validation studies for the Yfiler  Plus PCR Amplification Kit
using the 3130xl, 3500, or 3500xL configurations.

Genetic Operatin e
p 9 Collection | Additional software Run modules and conditions
Analyzer System
Software
3130 Windows™ 7 Data 3130/3730 DC v4 ¢ HIDFragmentAnalysis36_POP4_1 Injection
Collection 6-Dye Module v1 conditions: 3 kV/5 sec
Software v4!!] e Run conditions: 15 kV/1500 sec
e Dye Set J6
3130 x/ e HIDFragmentAnalysis36_POP4_1 Injection

conditions: 3 kV/10 sec

e Alternate injection condition for the 3130x¢:
3 kV/13 secl?

e Run conditions: 15 kV/1500 sec
e Dye Set J6

1" Requires activation of 6-dye license.

(21 This kit was developed using two injection voltage conditions for the 3130x 3 kV/10 sec and 3 kV/13 sec. You are encouraged to explore both
options during validation to determine which protocol provides the best results on your instrumentation.

Obtain and 1. Confirm that you are running Data Collection Software v4 (Help » About).
activate 6-dye
license 2. Obtain a 3130 DC v4 6-Dye Module v1 License key. Contact your local Human

Identification representative for information.
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O | Set up the 3130/3130xl instruments for electrophoresis (before first use of the kit/
3. Ensure that all network cards in the computer are enabled.
IMPORTANT! You can run the 3130 Series Data Collection Software v4 using
only the network cards that are enabled when you activate the software license.
For example, if you activate the software when your wireless network card is
disabled, you will not be able to run the software when the wireless network card
is enabled.
4. Select Tools » License Manager to display the Software Activation dialog box.
3xxx Series Data Collection Software 4 Software Activation =
1.  Requestlicense file for Computer ID:
d4bed2a7d416 d4bed2a7d417
This ID i unigue fo s computer and cannot be used fo obtain 3 ficense e for another computer,
a. Enter the license key (from CD ar email):
b. Enter your email address:
john.doe@thermofisher. com
c. Is this computer currently connected to the internet?
Yes. Connected. ] [ Mo. Mot Connected.
2. Refrieve the license file from email, then save it to the desktop of this computer.
3. Find the license file:
4. Click Install and Yalidate License l
5. Request the software license file by performing steps 1a, 1b, and 1c as listed on
the activation screen. The license file will be emailed to you.
6. Obtain the software license file from your email.
7. Make a copy of the software license file and keep it in a safe location.
8. Copy the software license file to the desktop of the Data Collection Software v4
computer.
9. If the Software Activation dialog box has closed, select Tools » License Manager.
36 Yfiler" Plus PCR Amplification Kit User Guide
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10. Click Browse, then navigate to the software license file saved on your computer.

11. Click Install and Validate License.
A message is displayed when the license is installed and validated.

12. Click Close.

Perform a spectral calibration using the DS-36 Matrix Standard Kit (Dye set J6, 6-dye)
(Cat. No. 4425042). Select the J6 dye set for the 3130 instrument, or the J6-RCT dye set
for the 3730 instrument.

The following figure is an example of a passing 6-dye spectral calibration.

Perform spectral
calibration

Intensity vs Scan Number

Prepare samples for electrophoresis (3500 Series and 3130 Series
instruments)

This procedure applies to the 3500 Series and 3130 Series instruments.

Prepare the samples for electrophoresis immediately before loading.

1. Pipet the required volumes of components into an appropriately sized

polypropylene tube:
Reagent Volume per reaction
GeneScan"-600 LIZ" Size Standard v2.0 0.4 pL
Hi-Di™ Formamide 9.6 L

Yiler" Plus PCR Amplification Kit User Guide 37



i’;:i:a Chapter 3 Perform electrophoresis
~ 20 Prepare samples for electrophoresis (3500 Series and 3130 Series instruments)

%

Note: Include volume for additional samples to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

2. Vortex the tube, then briefly centrifuge.

3. Into each well of a MicroAmp'" Optical 96-Well Reaction Plate, add:
* 10 pL of the formamide/size standard mixture
¢ 1 uL of PCR product or Allelic Ladder

Note: For blank wells, add 10 pL of Hi-Di" Formamide.

4. Seal the reaction plate with appropriate septa, then briefly vortex and centrifuge
the plate to ensure that the contents of each well are mixed and collected at the
bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.

6. Immediately place the plate on ice for 3 minutes.

7. Place the sample tray on the autosampler, then start the electrophoresis run.
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Analyze data with GeneMapper
/D-X Software

Overview of GeneMapper " ID-X Software ..............c.coiiriuin....
Allelic ladder requirements for data analysis .............................

File names and versionsused inthissection ............ ... ... . ... .......

Set up the GeneMapper'" ID-X Software for analysis (before first use of
the Kit) ... o

Create an analysismethod .......... ... ... ... ... . i il
Create a size standard definition fileifneeded ........................ ...
Analyze and edit sample files with GeneMapper'" ID-X Software ..........

Examineoreditaproject ......... ... .. .. i

For more information on using the GeneMapper'" ID-X Software ..........

Overview of GeneMapper  /D-XSoftware

GeneMapper' " ID-X Software is an automated genotyping software application for
forensic casework, databasing, and paternity data analysis.

GeneMapper' ' ID-X Software v1.4 or later analyzes 4-dye, 5-dye, and 6-dye data and

is required to correctly analyze data that is generated using the Yfiler " Plus PCR
Amplification Kit. After electrophoresis, the data collection software stores
information for each sample in a .fsa or .hid file. The GeneMapper ' ID-X Software
v1.4 or later allows you to analyze and interpret the data from the .fsa or .hid files.

Yfiler" Plus PCR Amplification Kit User Guide

39



e

%,

%

v;:’.‘ Chapter 4 Analyze data with GeneMapper™ /D-X Software

]

Allelic ladder requirements for data analysis

Allelic ladder requirements for data analysis

HID analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies before you use multiple allelic ladder
samples in an analysis.

For multiple allelic ladder samples, the GeneMapper " ID-X Software calculates
allelic bin offsets by using an average of all allelic ladders that use the same panel
in a run folder.

Allelic ladder samples in an individual run folder are considered to be from a
single run. When the software imports multiple run folders into a project, only
the ladders in their respective run folders are used for calculating allelic bin
offsets and subsequent genotyping.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type
column in a project. Analysis will fail if the Allelic Ladder Sample Type is not
specified.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can
contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.

File names and versions used in this section

40

The file names and version numbers of panel, bin, and stutter files that are shown in
this section may differ from the file names that you see when you download or import

files.

If you need help to determine the correct files to use, contact your local Human
Identification representative, or go to thermofisher.com/support.

Yiler"™ Plus PCR Amplification Kit User Guide
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Set up the GeneMapper  /D-XSoftware for analysis (before first use

of the kit)

Workflow: Set up
GeneMapper™
ID-X Software

Check panel, bin,
and stutter file
versions on your
computer

(If needed]
Download newer
versions of panel,
bin, and stutter
files

Before you use GeneMapper ' ID-X Software to analyze data for the first time, you
must do the following;:

“Check panel, bin, and stutter file versions on your computer” on page 41
v
“(If needed) Download newer versions of panel, bin, and stutter files” on page 41
v
“Import panels, bins, and marker stutter” on page 42
v

“(Optional] Define custom table or plot settings” on page 45

. Start the GeneMapper ' ID-X Software , then log in with the appropriate user

name and password.

. Select Tools » Panel Manager.

. Check the version of files that are currently available in the Panel Manager:

a. Select Panel Manager in the navigation pane.

b. Expand the Panel Manager folder and any subfolders to identify the
analysis file version that is already installed for your kit choice.

. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Panels folder, then check the version of panel,
bin, and stutter files installed.

. Check for newer versions of the files as described in the next procedure.

. Go to thermofisher.com/us/en/home/technical-resources/software-downloads/

genemapper-id-x-software.html.

2. If the file versions listed are newer than the versions on your computer,

download the file Yfiler Plus Analysis Files.

Note: When downloading new versions of analysis files, see the associated Read
Me file for details of changes between software file versions. Perform the
appropriate internal validation studies before using new file versions for
analysis.

. Unzip the file.
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Import panels, To import the latest panel, bin set, and marker stutter from the website into the
bins. and marker GeneMapper  ID-X Software database:
stutter 1. Start the GeneMapper ' ID-X Software, then log in with the appropriate user

name and password.
2. Select Tools » Panel Manager.
#* Panel Manager

3. Find, then open the folder containing the Fil= Edt Bins View Help
panels, bins, and marker stutter:

OX WHEN

= " Panel Manager

a. Select Panel Manager, then select File » Import Panels to open the Import
Panels dialog box.

b. Navigate to, then open the Yfiler Plus Analysis Files folder that you
unzipped in the previous procedure.

4. Select Yfiler_Plus_Panels.txt, then click Import.

Note: Importing this file creates a new folder in the navigation pane of the Panel
Manager, Yfiler_Plus_Panels. This folder contains the panel and associated
markers.

-
Jl’ Import Panels M

Lookin: | . Yfiler Plus Analysis files_w 1% - | ? bE

. ¥filer_Plus_Bins_vl.tet

L =
&j E viler Plus Panels v1.te

Recent Items | Yfiler_Plus_Stutter_vl.bd

Desktop File name: ¥iler_Plus_Panels_v1.txt
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5. Import the bins file:
a. Select the Yfiler_Plus_Panels folder in the navigation pane.

-
_]_. Panel Manager u

File Edit Bins View Help

ai X | W M| W™ |ensec vierpusens.. - || i W 0 B H | @@EE)
- g, Panel Manager Panel Harme Comrument

) AmpFLSTR_Panels w3x | |1 [ffler_Plos_Panel_wi none
2 (i v filer_Plus_w1

’ QK ” Cancel ” Apply ” Help l

b. Select File » Import Bin Set to open the Import Bin Set dialog box.
c. Navigate to, then open the Yfiler Plus Analysis Files folder.

d. Select Yfiler_Plus_Bins.txt, then click Import.

Note: Importing this file associates the bin set with the panels in the
Yfiler_Plus_Panels folder.

”
,__}.." Import Bin Set ﬁ
Look in: | Yfiler Plus Anal... v: % | =

i & Vfiler_Plus_Bins_vl.bt
-i} || ¥filer_Plus_Panels_v1.bd
Recent [tems || ¥filer_Plus_Stutter v1.bet

Desktop File name: Yfiler_Plus_Bins_v1.

Import
E: Files of type: [ All Files -
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6. (Optional) View the imported panels and bins in the navigation pane: Double-
click the Yfiler_Plus_Panels folder.

The panel information is displayed in the right pane and the markers are
displayed below it.

4® Panel Manager =

File Edit Bins View Help

i % | B H OB | W= | 5o st [Yhier_Puus Binsv1 MG EE EEEEEEE | o

=) g3, Panel Manager Bbker Miome | Dye Golr |Dim 5im | Bl Sise | Control Alleles Bbitker | Comunents ¥ Biker | Ladder Allles

) AmpFLSTR Panels_vax | [1 [pvar6 e [s80  [138 |19 4 rone ] 10,11,12,13, 14,15, 16,17, 18,19,20,21,22,23,2%,25
50 Yfler_Plus_v1 EREEER Bue  [T4z0 [fa40 |13 4 naone 0 [#101512,15,1415,18,17
= @l |3 [pvsess Bue  [187.0 |257.0 |24 4 none = 122,23,24,25,26,77,28,29,30
DYs3asr EREEEE Bus |60z |314.2 |29 g none ] 34,35
DYS635 s [ovsear Bue  [al9.5  |393.5 |21 4 none ] 11,12,13,14,15, 16, 17,18,19,20,21,22,23, 24,25, 26,27
Dv53891 & |DVS460 Green  [75.1 1131 |11 4 none & 7,6,9,10,11,12,13,14
i EC:Z; |7 [ovsess Green  [115.0  [177.0 |17 4 none ] 11,12,13,14,15,16,17,18,19,20,21,22,23,24
DYs4ss & [ovs19 Green  [179.5  [229.5 |15 4 none [ 9,10,11,12,13,14,15,16,17, 18,19
- DY518 5 [GATA H+ Green (2314 (2694 |13 4 none O [6510,11,15151415
GATA_H4 10 |DVs+as Green |27l2 3452 |19 3 none = 14,15,16,17,16,19,20,21,22,23,24
E::;:? |11 |pvsa91 Green  [348.5  [4025 |11 4 rone O [567,891011,12,13,14,15,16
Dysass 12 [DVE4SE Velow |71 1350 |15 4 none ] 10,11,12,13,14,15, 16,17, 18,15,20,21,22,25,24
- DYS350 |13 [ovs3s0 velow [139.2 |197.2 |24 4 none = 17,18,19,20,21,22,23,24,25,26,27,26,29
DYS438 [14 [DvS438 Yelow [201.5 (2635 |12 5 none 0 6,7,8,9,10,11,12,13,14,15,16
i E;::?; |15 [ovsasz vellow |70 |326.5 |13 3 none O |[5567,8%10,11,12,13,14,15,16,17,15,13,20
DYssTn 16 |DVSS1E velow [327.6 |406.0 |37 4 none ] [52,33,34,35,26,37,36,59,90,41, 42,435,244, 45,46, 47,48,48
DYS437 |17 [ovss70 Red (935 |1675 |17 B none = 10,11,12,13,14,15,16,17,18,19,20,21,22,23,24, 25,26
DYS385 18 |DVS437 Red 1733 2153 |15 4 none ] 10,11,12,13,14,15,16,17,18
'E:g:: |19 [DVE385 Red  [2204  [31&4  [ILIF 4 none T |&78510,11,15,13,14,15,16,17,18,13,20,21 4,25,26,27, 28
- Y543 20 |DV5448 Red  [3208 |4038 |30 4 none ] |22,23,24,25,26,27,28,29,30,31,32,33,34,35,36,37,36,35,40
DYS481 [21 [Dvs393 Purple E 36 (13936 |13 4 none 0 7,8,9,10,11,12,13,14,15,16,17,18
DiF38751 |22 [Dvs4as Puple (1456 (1996 |12 4 none O [6789,10,11,12,13,14,15,16,17
prssss 23 [DV34aL Puple (2030|2560 |22 3 none ] 17,18,19,20,21 4,25,26,27,28,29,30,31
[24 [DvF387S1 Purple ’W’E.u |"35,37" 4 none ] 30,31,32,33,34,35,36,37,35,39,40,41,42,43,44
|25 o833 Puple (3359 (3839 [13 4 none ] 7,8,9,10,11,12,13,14, 15,16, 17
i Reference Samples

7. Import the stutter file:
a. Select the Yfiler_Plus_Panels folder in the navigation panel.

b. Select File » Import Marker Stutter to open the Import Marker Stutter
dialog box.

c. Navigate to, then open the Yfiler Plus Analysis Files folder.

d. Select Yfiler_Plus_Stutter.txt, then click Import.

Note: Importing this file associates the marker stutter ratio with the bin set
in the Yfiler_Plus_Panels folder and overwrites any existing stutter ratios
associated with the panels and bins in that folder.

-
J'.' Import Marker Stutter ﬂ

Look in: [ . Yfiler Plus Analysis files_v 1X =] ? ’”E|

=  Yfiler_Plus_Bins_v1.bd
-‘;r_)'}‘ _ Yfiler_Plus_Panels_v1.bd

Recent Items . Yfiler_Plus_Stutter vl.td

Desktop §
File name: Yiler_Plus_Stutter_w1.txt
| 5

8. View the imported marker stutters in the navigation pane:
a. Double-click the Yfiler Plus_Panels folder to display the folder.
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b. Double-click the folder to display its list of markers below it.

c. Double-click a marker to display the Stutter Ratio & Distance view for the
marker in the right pane.

® Panel Manager =
File Edit Bins View Help
o < | W B B | W™ | bnset vfer pius fins vi JHMLESE EEEEEEN e
(= Yfiler_Plus_Panel_v1 -
DYS575 Please enter the stutter filter(s) for DYS578 marker here If left blank, the global stutter filter will be applied
B Stutter Ratio & Distance [l
Ds38st Minus Stutter Plus Stutter
DY5635
DYS389IL Ratio From Distance To Distance Ratio From Distance To Distance
DYse27 1 L1515 3.25 4.75 1 L0341 3.25 +.75
DYS460 = 2 2
DYS458
DYs1 3 3
GATA_H4 4 4
DYS448 -
orsaa1 4
DYS458
DYS390
D¥5438
DYS392
DYS518
NYSSN. S

9. Click Apply, then click OK to add the panel, bin set, and marker stutter to the
GeneMapper'" ID-X Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter are not imported into the GeneMapper" ID-X
Software database.

[Optional) Define Default views for table and plot settings are provided with the software. For
custom table or information on defining custom views, see GeneMapper" ID-X Software Getting Started
plot settings Guide— Basic Features.
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Create an analysis method

Create an analysis
method

46

IMPORTANT! Analysis methods are version-specific, so you must create an analysis
method for each version of the software. For example, an analysis method that is
created in GeneMapper  ID-X Software version 1.2 is not compatible with analysis
methods that are created in earlier versions of software, or with GeneMapper
Software v3.2.1.

1.

Select Tools » GeneMapper® ID-X Manager to open the GeneMapper ID-X
Manager.

-

¥ GeneMapper® ID-X Manager

Find Name Containing:

Projects | Analysis Methods | Table Settings | Piot Settings | Matrices | Size Standards | Report Settings|
[ Mew.. || open.. || savess.. |[ Import.. |[ Export.. |

it (s

2. Click the Analysis Methods tab, then click New to open the Analysis Method

Editor with the General tab selected.

Enter the settings shown in the figures on the following pages.

Note: The Analysis Method Editor closes when you save your settings. To
complete this step quickly, do not save the analysis method until you finish
entering settings in all of the tabs.

4. After you enter the settings on all tabs, click Save.
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Enter Analysis Enter General tab settings
Method settings 1. Enter a Name and select the Security Group appropriate for your software
configuration.
Analysis Method Editor %
General | Allele | Peak Detector | Peak Quality | 5Q & GQ Settings |
—Analysis Method Description
Mame: Yfiler Plus Analysis Method
Security Group: .GeneMapper ID-X Security Group - .
Description: -
=
Instrument:
Analysis Type: HID
Save As ] [ Save ] [ Cancel ] [ Help ]

2. (Optional) Enter a Description and Instrument.
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Create an analysis method

m Chapter 4 Analyze data with GeneMapper™ /D-X Software

Enter Allele tab settings

IMPORTANT! To determine the appropriate settings to use, perform appropriate
internal validation studies.

1.

Select the Yfiler_Plus_Bins bin set.

il N
Analysis Methad Editor %
| General | Allele | peak Detector | Peak Quality | 5Q & GQ Settings|
Bin Set: .Yﬁler_PIus_Bins_ul -
Use marker-specific stutter ratio and distance if available
Marker Repeat Type: Tri Tetra Penta Hexa
Global Cut-off Value 0.0 0.0 0.0 0.0
MinusA Ratio 0.0 0.0 0.0 0.0
MinusA Distance From 0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0
Global Minus Stutter Ratio 0.0 0.0 0.0 0.0
Global Minus Stutter Distance  From 0.0 3.25 0.0 0.0
Te |0.0 4,75 0.0 0.0
Global Plus Stutter Ratio 0.0 0.0 0.0 0.0
Global Plus Stutter Distance From [0.0 0.0 0.0 0.0
To 0.0 0.0 0.0 0.0
Amelogenin Cutoff 0.0
Range Filter... Factory Defaults
Save As ] [ Save l [ Cancel ] [ Help ]

Figure 3 Settings used in developmental validation of the kit
(Optional) To apply the stutter ratios that are contained in the

Yfiler_Plus_Stutter.txt, select the Use marker-specific stutter ratio and distance
if available checkbox (selected by default).
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Create an analysis method

3. If using GeneMapper  ID-X Software v1.4 or later, enter values for the 4 Marker

Repeat Types.

4. Enter the appropriate filter settings.

Enter Peak Detector tab settings

Enter the appropriate values:

Field Values to enter or select Additional information
Ranges Enter the values shown in Figure 4. -
Peak Enter the appropriate settings. The software uses these parameters to specify
Detection the minimum peak height, in order to limit the

IMPORTANT! Perform appropriate internal
validation studies to determine the appropriate
peak amplitude thresholds for interpretation of
data.

number of detected peaks. Although
GeneMapper " /D-XSoftware displays peaks that
fall below the specified amplitude in
electropherograms, the software does not label
or determine the genotype of these peaks.

Smoothing and
Baseline

Enter the values shown in Figure 4, or adjust if
needed dependent on the polymer you are using.

3730 DNA Analyzer with POP-7" polymer only:
With the Smoothing setting of None, the
instances of spacing failures for the D25441 and
D1S1656 markers in some allelic ladder samples
are significantly reduced. With the default
Smoothing setting of Light, failures of base-pair
spacing quality assessment are observed.

For more information, see the GeneMapper"
ID-X Software v1.4 New Features and Installation
Procedures User Bulletin (Pub. No. 4477684 Rev.
BJ, "Known issues: 3730 DNA Analyzer allelic
ladder failures”.

Yfiler" Plus PCR Amplification Kit User Guide
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Create an analysis method

by your laboratory.

IMPORTANT! The Yfiler" Plus PCR
Amplification Kit has been validated with data
that was analyzed using both the 3rd Order
Least Squares method (80-460 base pairs) and
the Local Southern Method (60-460 base pairs).

Field Values to enter or select Additional information
Size Calling Select 3rd Order Least Squares method or Local -
Method Southern Method or another method if validated

Normalization

(Optional/Select the Normalization checkbox.
Ensure that your internal validation supports the
selection of this feature.

A Normalization checkbox is available on this
tab in GeneMapper™ /D-X Software for use in
conjunction with data run on the 3500 Series
Genetic Analyzers.

50

Yiler" Plus PCR Amplification Kit User Guide




Chapter 4 Analyze data with GeneMapper™ /D-X Software
Create an analysis method

p
Analysis Method Editor 2
General | Allle | Peak Detector | peak Quality | 5Q & GQ Settings |
Peak Detection Algorithm: Advanced
Ranges Peak Detection
Analysis _ Sizing Peak Amplitude Thresholds:
Full Range + | | All Sizes B: R
Start Pt|0 Start Size:|0 ) :
Stop Pt: | 10000 Stop Size: | 1000 & &
¥ O
—Smoothing and Baselining
Min. Peak Half Width: |2 pts
Smoothing () Mone
- i : 3
@ Light Polynomial Degree:
(T) Heavy Peak Window Size: 13 pts
Baseline Window: |33 pts Slope Threshold
Peak Start: 0.0
~Size Calling Method Peak End: 0.0
(™) 2nd Order Least Squares
(7 3rd Order Least Squares Marmalization
uj;ju Cubic Spline Interpolation [Z] Use Normalization, if applicable
(@) Local Southern Method
(") Global Southern Method
’ Factory Defaults
Save As ] [ Save ] [ Cancel ] [ Help ]

L

Figure 4 Settings used in the internal validation of the kit
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Enter Peak Quality tab settings

IMPORTANT! Perform the appropriate internal validation studies to determine the
heterozygous and homozygous minimum peak height thresholds, maximum peak
height threshold, and the minimum peak height ratio threshold for interpretation of
data.

Enter the following values:

Analysis Method Editor X

| General | Allele | Peak Detector | Peak Quality | s & GQ Settings |
Min/Max Peak Height (LPH/MPH)

Homozygous min peak height
Heterozygous min peak height
Max Peak Height (MPH)

Peak Height Ratio (PHR)
Min peak height ratio

Broad Peak (BD)
Max peak width (basepairs) 1.5

Allele Mumber (AM)
Max expected alleles:
For autosomal markers & AMEL 2
For ' markers 1
Allelic Ladder Spike
Spike Detection Enable .
Cut-off Value 0.2

Sample Spike Detection
Spike Detection Enable

’ Factory Defaults

Save As H Save ][ Cancel H Help ]
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Enter SQ and GQ tab settings

IMPORTANT! The values that are shown are the software defaults and are the values
that we used during developmental validation. To determine the appropriate values
to use, perform appropriate internal validation studies.

Enter the following values:

a
Analysis Method Editor 2
| General | Allele I Peak Detector | Peak Quality | 50 &GO Settings
Quality weights are between 0 and 1.

—Sample and Contral GQ Weighting
Broad Peak (BD) 0.3 Allele Mumber (AMN) 1.0
Qut of Bin Allele (BIM) 0.8 Low Peak Height (LPH) 0.3
Cverlap (QVL) 0.3 Max Peak Height (MPH) 0.3
Marker Spike (SPE) 0.3 Off-scale (03) 0.8
AMEL Cross Check (ACC) 0.0 Peak Height Ratio (FHR) 0.3
Control Concordance (CC) Weight = 1.0 (Only applicable to controls)

—50 Weighting
Broad Peak (BD) 0.5

—Allelic Ladder GO Weighting
Spike (SSPK/SPK) 1 v Off-scale (05) 1 v

~50Q & G0 Ranges
Sizing Quality: From |0.73 to 1.0 From0.0to |0.25
Genotype Quality: From |0.75 to 1.0 From0.0to |0.25

I Reset Defaults
Save As ] [ Save ] [ Cancel ] [ Help ]
L. -
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Create a size standard definition file if needed

Create a size standard definition file if needed

About the
GS600_LIZ_ (60-
460) size standard
definition file

Create a size
standard
definition file

54

If you cannot use the default settings that are provided, create a new size standard
definition file.

The GS600_LIZ_(60-460) size standard definition that is provided with GeneMapper -
ID-X Software and used with the Local Southern size calling method contains the
following peaks: 60, 80, 100, 114, 120, 140, 160, 180, 200, 214, 220, 240, 250, 260, 280,

300, 314, 320, 340, 360, 380, 400, 414, 420, 440, and 460.

This size standard definition has been validated for use with this kit on the genetic
analyzers listed in “Instruments and software compatibility” on page 15 . If you need
to create your own size standard definition, see “Create a size standard definition
file” on page 54.

1. Select Tools » GeneMapper ID-X Manager to open the GeneMapper ID-X
Manager.

2. Click the Size Standards tab, then click New.

-
¥ GeneMapper® ID-X Manager

Fird M C o Eairing:

Projects | Analysis Methods | Tabie Settings | Plot Settings | Matrices | Size Standards | Report Settings|

Mame Last Saved [Covinen Type Description
|CE_F_HID_GS500 {75-400) m:n-u:a-u-;lazzs;s[q-ﬁdx |Advanced

CE_F_HID_GS500 (75-4500 |zuu?-m3-uq I3:24:[||;mdx Advanced |
E_G5_HID_5500 2006-10-11 I3r|2::||;|nidx Advanced

|G5600_LIZ 2007-06-26 10:43; I[nl'fidx |Advanced
GSE00_LIZ+Mormalization_{ |2mz-m-ne |2:3?::||;mdx Advanced |
G5600_LIZ+Normalization _{ | 2007-06-27 01:43; I||;|nidx Advanced

| GSE00_LIZ_(E0-+60) 2012-08-06 |2:21::[nmidx |Advanced

G5600_LIZ_(50-400) Advanced

|znm-ne-2:r 0043 I||;rridx

[«

L1

3. Specify settings in the Size Standard Editor:

a.

b.

software configuration.

In the Size Standard Dye field, select Orange.

Enter a name as shown in the following figure or enter a new name.

In the Security Group field, select the Security Group appropriate for your

Yfiler" Plus PCR Amplification Kit User Guide
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Create a size standard definition file if needed

d. In the Size Standard Table, enter the peak sizes that correspond to your size

standard.

| 4® Size Standard Editor S

Edit

Mame:

Description:

—Size Standard Description

Security Group:

Size Standard Dye:

GS600_LIZ_{50-450)

:GeneMapper ID-X Security Group

'Dfange - '

FEe——
Ll

—Size Standard Table

Size in Basepairs

0.0

[ Insert H Delete

I.p

g0.0

100.0

$al | M2

114.0

120.0

140.0

m

1a0.0

150.0

£00.0

Z£14.0

220.0

240.0

250.0

14

2a0.0

15

£80.0

300.0

17

314.0

[ oK H Cancel ][ Help ]
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Analyze and edit sample files with GeneMapper" ID-X Software

Analyze and edit sample files with GeneMapper~ /D-XSoftware

1. In the Project window, select Edit » Add Samples to Project, then navigate to the
disk or directory that contains the sample files.

2. Apply analysis settings to the samples in the project.

Parameter

Settings

Sample Type

Select the sample type.

Analysis Method

Select Yfiler_Plus_AnalysisMethod (or the name of the
analysis method you created).

Panel

Select Yfiler_Plus_panels.

Size Standard

Use a size range of 60-460 bp for Local Southern size calling
method or a size range of 80-460 bp for 3rd Order Least
Squares size-calling method.!"]

0 The Yfiler™ Plus PCR Amplification Kit was originally validated with the GeneScan™-600 LIZ™ Size

Standard v2.0. If you use a different size standard, perform the appropriate internal validation studies to
support the use of this size standard with the Yfiler™ Plus PCR Amplification Kit.

3. Click Analyze, enter a name for the project (in the Save Project dialog box), then
click OK to start analysis.

The status bar displays the progress of analysis as a completion bar.

The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

The Analysis Summary tab is displayed, and the Genotypes tab is available
when the analysis is complete.

File Edt Analyss View Tools Admin Help

sy Complted,

56

COH | &F  BEEWUN|BEE| > @ | rbesens: | 3000 mis o
[

Bl rER |2 e

Sonpls] At Sommry | Gty

Analysis Summary

Selectrun folder o dpley: (AL

Control Qualty per project (based on sample PQVS: SO, SSPK, MIX, OMR, S0, C6Q)

Tora 7 ofSanles ][0 A vesoamet ][ @ O o s e ot
o o o

] ]
[ [

‘Sample Quality per project (based on sample PQVs: SOS, SSPIC MIX, ONR, 50, C60)

0
0

Tora = ofsanpes ]l Altveshodsmer ][ @ One ormare o ratner ]
E) By )

Sampes =
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Chapter 4 Analyze data with GeneMapper™ /D-X Software
Examine or edit a project

Examine or edit a project

Display electropherogram plots from the Samples and Genotypes tabs of the Project
window to examine the data.

For more information on using the GeneMapperTM ID-X Software

See “Related documentation” on page 123 for a list of available documents.
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Importance of validation

Validation of a DNA typing procedure for human identification applications is an
evaluation of the efficiency, reliability, and performance characteristics of the
procedure. By challenging the procedure with samples that are commonly
encountered in forensic and parentage laboratories, the validation process uncovers
attributes and limitations that are critical for sound data interpretation (Sparkes,
Kimpton, Watson, 1996; Sparkes, Kimpton, Gilbard, 1996; Wallin, 1998).

Experiment conditions

58

We conducted developmental validation experiments according to the updated and
revised guidelines from the Scientific Working Group on DNA Analysis Methods
(SWGDAM, December 2012). Based on these guidelines, we conducted experiments
that comply with guidelines 2.0 and 3.0 and its associated subsections. This DNA

methodology is not novel. (Moretti et al., 2001; Frank et al., 2001; Wallin et al., 2002; and

Holt et al., 2000).

We used conditions that produced optimum PCR product yield and that met
reproducible performance standards. It is our opinion that while these experiments
are not exhaustive, they are appropriate for a manufacturer of STR kits intended for
forensic and/or parentage testing use.

Yiler"™ Plus PCR Amplification Kit User Guide
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Laboratory requirements for internal validation

Laboratory requirements for internal validation

Each laboratory using this kit must perform internal validation studies. Performance
of this kit is supported when used according to the following developmentally
validated parameters. Modifications to the protocol should be accompanied by
appropriate validation studies performed by the laboratory.

Developmental validation

SWGDAM
guideline 2.2.1

SWGDAM
guideline 3.9.2

PCR components

Except where noted, all developmental validation studies were performed using the
Veriti" Thermal Cycler according to the protocol described in the Perform PCR
chapter.

“Developmental validation is the acquisition of test data and determination of
conditions and limitations of a new or novel DNA methodology for use on forensic,
database, known or casework reference samples.” (SWGDAM, December 2012)

“The reaction conditions needed to provide the required degree of specificity and
robustness should be determined. These include, but are not limited to, thermal
cycling parameters, the concentration of primers, magnesium chloride, DNA
polymerase, and other critical reagents.” (SWGDAM, December 2012)

We examined the concentration of each component of the kit. We established that the
concentration of each component was within the range where data indicated that the
amplification met the required performance criteria for specificity, sensitivity, and
reproducibility. For example, blood and buccal samples on treated-paper substrates or
swab-sample lysates were amplified in the presence of varying concentrations of
magnesium chloride, and the results were analyzed on a 3500xL Genetic Analyzer.
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The performance of the multiplex is most robust within +20% of the optimal

magnesium chloride concentration.

Mk Sampe forDeleon
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Figure 5 Electropherogram obtained from the amplification of a mixture of 1 ng of male
007 DNA and 1 ug of female 9947 DNA with varying concentrations of MgCl, analyzed on a

3500xL Genetic Analyzer (Y-axis scale 0 to 13,000 RFU).
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Figure 6 Electropherogram obtained from the amplification of a blood sample onFTA"
card amplified with the Yfiler™ Plus kit in the presence of varying concentrations of MgCl,

and analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to 10,000 RFU).
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Figure 7 Electropherograms obtained from the amplification of a buccal sample on FTA™
card amplified with the Yfiler" Plus kit in the presence of varying concentrations of MgCl,
and analyzed on a 3500xL Genetic Analyzer (Y-axis scale 0 to 20,000 RFU).

+20%

Thermal cycling parameters were optimized using a Design of Experiments (DOE)
approach that attempts to identify the combination of temperatures and hold times
that produce the best assay performance. Optimal assay performance was determined
through evaluation of assay sensitivity, peak-height balance, and resistance to PCR
inhibitors.

The denaturation temperatures tested were 93°C, 94°C, and 95°C, all for 4-second
hold times on the Veriti Thermal Cycler. The annealing temperatures tested were
60.5, 61, 61.5, 62, and 62.5°C, for 1-minute hold times in the Veriti Thermal Cycler.
The PCR products were analyzed using the 3500xL. Genetic Analyzer.

No preferential amplification was observed in the denaturation temperature
experiments. Of the tested annealing temperatures, 61°C, 61.5°C, and 62°C produced
robust profiles with no significant cross reactivity to 1 pug of female DNA. At 62.5°C,
the yield of most loci was reduced. This poses no problem with routine thermal cycler
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evelopmental validation

calibration and when following the recommended amplification protocol. Preferential
amplification was not observed at the standard annealing temperature of 61.5°C.

0
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Figure 8 Electropherogram obtained from the amplification of a mixture of 1 ng of male
007 DNA and 1 pg of female 9947 DNA with varying annealing temperatures analyzed on a

3500xL Genetic Analyzer (Y-axis scale 0 to 8,000 RFU).
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Figure 9 Electropherogram obtained from the amplification of a mixture of a blood sample
on an FTA" card with varying annealing temperatures analyzed on a 3500xL Genetic
Analyzer (Y-axis scale 0 to 12,000 RFU).
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Figure 10 Electropherogram obtained from the amplification of a mixture of a buccal
sample on an FTA™ card with varying annealing temperatures analyzed on a 3500xL
Genetic Analyzer (Y-axis scale 0 to 10,000 RFU].

Accuracy, precision, and reproducibility

SWGDAM
guideline 3.5

Accuracy
observation

“Precision and accuracy of the assay should be demonstrated: Precision characterizes
the degree of mutual agreement among a series of individual measurements, values
and/or results. Precision depends only on the distribution of random errors and does
not relate to the true value or specified value. The measure of precision is usually
expressed in terms of imprecision and computed as a standard deviation of the test
results. Accuracy is the degree of conformity of a measured quantity to its actual
(true) value. Accuracy of a measuring instrument is the ability of a measuring
instrument to give responses close to a true value.” (SWGDAM, December 2012)

Laser-induced fluorescence detection of length polymorphism at short tandem repeat
loci is not a novel methodology (Holt et al., 2000; Wallin ef al., 2002). However,
accuracy and reproducibility of profiles have been determined from various sample

types.

Figure 11 shows the size differences that are typically observed between sarglwple
alleles and allelic ladder alleles on the 3500xL Genetic Analyzer with POP-4
Polymer. The X-axis represents the nominal nucleotide sizes for the Yfiler " Plus
Allelic Ladder. The dashed lines parallel to the X-axis represent the +0.5-nt windows.
The Y-axis represents the deviation of each sample allele size from the corresponding
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" Accuracy, precision, and reproducibility

Yfiler " Plus Allelic Ladder allele size. All sample alleles are within 0.5 nt from a
corresponding allele in the Yfiler Plus Allelic Ladder.

Precision (3500xI)
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1.0 e DYF38751
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+
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Figure 11 Size deviation of 78 samples analyzed on the 3500xL Genetic Analyzer

Sizing precision enables the determination of accurate and reliable genotypes. The
recommended method for genotyping is to use a +0.5-nt “window” around the size
obtained for each allele in the allelic ladder. A +0.5-nt window allows for the detection
and correct assignment of alleles. Any sample allele that sizes outside the specified
window could be either:

* An “off-ladder” allele, that is, an allele of a size that is not represented in the
allelic ladder.

¢ An allele that does correspond to an allele in the allelic ladder, but whose size is
just outside a window because of measurement error.

The measurement error inherent in any sizing method can be defined by the degree of
precision in sizing an allele multiple times. Precision is measured by calculating the
standard deviation in the size values obtained for an allele that is run in several
injections on a capillary instrument.

To view a table of typical precision results, see Table 9.
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Extra peaks in the electropherogram

J

Extra peaks in the electropherogram

Causes of extra
peaks

Extra peaks:
Stutter

Peaks other than the target alleles may be detected on the electropherogram. Causes
for the appearance of extra peaks include stutter products, incomplete 3" A nucleotide
addition (at the n-1 position), dye artifacts, and mixed DNA samples (see DNA
Advisory Board (DAB) Standard 8.1.2.2).

Stutter definition

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller than the target STR allele product (minus stutter), or less
frequently, one repeat larger (plus stutter) (Butler, 2005; Mulero et al., 2006). Sequence
analysis of stutter products at tetranucleotide STR loci has revealed that the minus
stutter product is missing a single tetranucleotide core repeat unit relative to the main
allele (Walsh et al., 1996). Although plus-stutter is normally much less significant than
minus-stutter in STR loci with tetranucleotide repeats, the incidence of plus-stutter
may be more significant in trinucleotide repeat-containing loci.

Contact HID Support for more information on plus stutter.

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak.

Stutter observations

Peak heights were measured for amplified samples at the loci used in the kit. All data
were generated on the 3500xL Genetic Analyzer. Some conclusions from these
measurements and observations are:

* For each locus, the stutter percentage generally increases with allele length.

¢ Smaller alleles display a lower level of stutter relative to the longer alleles within
each locus.

* Each allele within a locus displays a consistent stutter percentage.

* Peaks in the stutter position that are above the stutter filter percentage specified
in the software are not filtered (stutter filter percentage is calculated as the mean
stutter for the locus plus three standard deviations). Peaks in the stutter position
that have not been filtered and remain labeled can be further evaluated.

¢ The measurement of stutter percentage for allele peaks that are off-scale may be
unusually high due to artificial truncation of the main allele peak.

Marker-specific plus stutter observed in the population study with the Yfiler" Plus
PCR Amplification Kit is shown in Figure 12 through Figure 20 and listed in Table 3.
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Additional marker-specific plus stutter observed in the population study with the
Yfiler” Plus PCR Amplification Kit is listed in “Stutter percentage filter settings
provided with GeneMapper " ID-X Software” on page 75.
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Figure 12 Minus stutter percentages for the DYF387S1, DYS19, and DYS385 a/b loci. (Blue,
green, black, red, and purple colors indicate loci labeled with 6-FAM™ VIC™ NED™, TAZ",

and SID™ dyes, respectively.)
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and SID™ dyes, respectively.)
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and SID™ dyes, respectively.)
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Figure 16 Minus stutter percentages for the DYS458, DYS460, DYS481, and DYS518 loci.
(Blue, green, black, red, and purple colors indicate loci labeled 6-FAM™, VIC™, NED™, TAZ™,
and SID™ dyes, respectively.)
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SID™ dyes, respectively.)
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Figure 19 Example of reproducible 2-nt stutters in the DYS19 loci.
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Figure 20 Example of reproducible 2-nt stutters in the DYS481 loci.
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Stutter percentage filter settings provided with GeneMapper™ /D-X Software

The settings in Table 3 were derived using the data that is shown earlier in this
section. The proportion of the stutter product relative to the main allele (stutter
percent) is measured by dividing the height of the stutter peak by the height of the
main allele peak.

IMPORTANT! The values that are shown in the table are the values that were
determined during developmental validation studies using specific data sets. To
determine the appropriate values to use for your applications, always perform
internal validation studies.

Table 3 Marker-specific % minus stutter for the Yfiler™ Plus kit loci

% Minus
Locus S[::Il:;enr % Mean % Minimum | % Maximum igt:fa:;:::
+3standard | StUter stutter stutter | Jeviations)['!
deviations)!!
DYS576 15.15 10.44 5.95 20.27 f21
DYS389! 9.16 6.08 3.47 10.88 [21
DYS635 13.38 7.54 2.82 21.59 [2]
DYS389lI 18.79 13.88 9.15 20.88 [2]
DYS627 15.18 9.90 5.14 28.17 2.71
DYS460 11.65 7.32 0.58 13.92 f21
DYS458 15.31 10.58 3.58 16.74 [21
DYS19 12.68 8.27 0.86 15.12 10.10
YGATAH4 11.53 7.75 4.07 22.14 [2]
DYS448 4.68 2.62 0.66 13.11 f21
DYS391 9.99 6.58 3.23 13.25 f21
DYS456 15.36 11.34 7.10 17.62 [21
DYS390 13.58 8.74 4.72 16.21 [2]
DYS438 5.86 3.59 1.50 7.62 [2]
DYS392 16.94 10.27 3.27 31.35 f21
DYS518 25.50 18.07 11.70 46.29 f21
DYS570 15.65 10.88 412 21.49 [2]
DYS437 8.13 4.83 1.60 13.26 f2]
DYS385 a/b 18.32 10.02 3.26 21.54 [2]
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% Minus
Locus S[::I":;enr % Mean % Minimum | % Maximum igt;fa:;:::
+3standard | StUter stutter stutter | Jeviations)['!
deviations)!!
DYS449 23.24 16.80 11.40 25.61 f2]
DYS393 14.07 9.97 6.63 19.17 f21
DYS439 9.89 6.74 3.55 11.98 [2]
DYS481 28.55 19.98 12.02 28.95 9.55
DYF387S1 15.71 9.96 441 30.78 [2]
DYS533 12.00 7.94 2.37 18.11 1.88
' These percentages are used as stutter filters in GeneMapper ID-X Yfiler_Plus_Stutter.txt
2@ Undetermined
Table 4 Marker-specific % plus stutter for the Yfiler™ Plus kit loci
% Plus
Locus [T\:z::: % Mean % Minimum | % Maximum igt;f’am:?:
S stutter stutter stutter | 4 ons)l1]
deviations)!!
DYS576 3.38 1.15 0.42 8.45 f2]
DYS389! 3.45 0.81 0.23 8.94 f21
DYS635 3.30 1.06 0.26 6.94 [21
DYS389ll 3.73 1.01 0.33 9.35 [2]
DYS627 2.62 0.95 0.26 6.40 [2]
DYS460 4.27 1.17 0.34 24.71 f21
DYS458 2.52 0.95 0.34 5.86 f21
DYS19 3.72 1.26 0.43 14.81 3.42
YGATAH4 2.27 0.94 0.33 4.55 f2]
DYS448 2.29 0.76 0.25 3.40 [21
DYS391 3.41 0.98 0.33 9.02 f21
DYS456 3.74 2.03 0.73 7.09 [21
DYS390 3.51 1.19 0.35 3.36 [2]
DYS438 2.76 0.97 0.35 2.87 [2]
DYS392 11.00 6.32 1.91 16.65 f21
DYS518 4.85 1.78 0.69 13.46 f21
76 Yfiler" Plus PCR Amplification Kit User Guide




Extra peaks:

Addition of 3" A

nucleotide

Chapter 5 Experiments and results B
Extra peaks in the electropherogram A

-
<Ol
5

%
)
"

% Plus
Locus [i::tat:: % Mean % Minimum | % Maximum igt:fa:;:::
e stutter stutter stutter | 4 ons)l1]
deviations)!!
DYS570 2.88 1.15 0.45 10.50 f2]
DYS437 1.65 0.70 0.23 2.28 f21
DYS385 a/b 3.70 1.12 0.19 13.17 [2]
DYS449 4.20 1.50 0.57 12.83 [2]
DYS393 4.95 2.07 0.59 22.21 [2]
DYS439 3.39 1.24 0.43 14.17 f21
DYS481 5.59 2.59 0.96 21.03 f21
DYF38751 [2] [2] [2] [2] [2]
DYS533 4.60 1.71 0.70 5.73 [2]

1 These percentages are used as stutter filters in GeneMapper ID-X Yfiler_Plus_Stutter.txt
[ Undetermined

3’ A nucleotide addition definition

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3’ ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product that
is one nucleotide longer than the actual target sequence. The PCR product with the
extra nucleotide is referred to as the “+A” form.

3’ A observations

The efficiency of +A addition is related to the particular sequence of the DNA at the 3’
end of the PCR product.

™

The Yfiler " Plus PCR Amplification Kit includes two main design features that
promote maximum +A addition:

¢ The primer sequences have been optimized to encourage +A addition.

¢ The PCR chemistry allows complete +A addition with a short final incubation at
The new, highly robust PCR chemistry allows complete +A addition with a short
final incubation at 60°C for 22 minutes. .

This final extension step gives the DNA polymerase additional time to complete +A
addition to all double-stranded PCR products. Figure 21 shows examples of
incomplete and normal +A addition. Final extension incubation for longer than the
recommended time can result in double +A addition, in which two nontemplate
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adenosine residues are added to the PCR product. Double +A addition can cause
"shoulders" on the right side of main allele peaks, and is therefore to be avoided.

230 240 240
4000 t t 1 t t

000 4 7 minutes

230 240 2al
4000 t t
2000 } 12 minutes
i}
230 240 2al
4000 t + + + +
2000 + 17 minutes
1]
230 240 2al
4000 ' ' ' ' '
000 + 22 minutes
a

Figure 21 Omitting the final extension step results in shoulders on main allele peaks due
to incomplete A nucleotide addition. Examples shown are the smaller amplicons of FAM™,
NED™, and SID™ dye channel data from a 3500xL Genetic Analyzer using the Yfiler™ Plus
PCR Amplification Kit.

Due to improved PCR buffer chemistry, the lack of +A addition is generally less of an
issue with the Yfiler " Plus PCR Amplification Kit than with earlier generation kits.
However, "shouldering" of allele peaks can still be observed if the amount of input
DNA is greater than recommended concentration. Amplification of excess input DNA
can also result in off-scale data.
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Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible. Anomalies are non-reproducible, intermittent occurrences that
are not observed consistently in a system (for example, spikes and baseline noise).

Artifact observation

Additional reproducible DNA-dependent artifacts have been characterized and
recorded on Table 5. It is important to consider possible noise and artifacts when
interpreting data from the Yfiler" Plus kit on the 3500/3500xL and 3130/3130x! Genetic

Analyzers.

Table 5 DNA-dependent artifacts

Artifact Color Size Comment

FAM270 Blue 270-271 Minor cross-reactive product observed with
female DNA in excess of 2 ug.

FAM280 Blue 280-281 Minor cross-reactive product observed with
female DNA in excess of 2 pg.

FAM348 Blue 348-349 Specific to cell-line derived kit Control DNA.

DYS391 (n-10)| Green n-10nt Specific to DYS391. Minor cross-reactive
product observed with male DNA in excess of
1.0 ng.

TAZ140 Red 139-140 Minor cross-reactive product observed with
female DNA in excess of 2 ug.

TAZ144 Red 144-145 Minor cross-reactive product observed with
female DNA in excess of 2 ug.

TAZ225-260 Red 225-260 Multiple minor cross-reactive products
observed with female DNA in excess of 2 pg.

TAZ412 Red 412-413 Cross-reactive product observed with female
DNA in excess of 100 ng. Occurs outside of
the read region. Does not impact
interpretation.

VIC70 Green 70 Sporadic PCR artifact. Occurs outside of the
VIC™ read region. Does not impact
interpretation.

DYS437 (n-5) Red n-5nt Specific to DYS437. Sporadic, non-target
specific artifact.

DYS437 (n-12) Red n-12nt Specific to DYS437. Sporadic, non-target
specific artifact.

DYS437 (n-16) Red n-12nt Specific to DYS437. Sporadic, non-target

specific artifact.
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Figure 22 Example of the TAZ412 reproducible artifact in data produced on the

3500/3500xL Genetic Analyzer.
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Figure 23 Example of the FAM348 reproducible artifact in data produced on the
3500/3500xL Genetic Analyzer.
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Figure 24 Example of the DYS391 (n-10) reproducible artifact in data produced on the
3500/3500xL Genetic Analyzer.
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Figure 25 Examples of the DYS437 artifacts in data produced on the 3500/3500xL Genetic
Analyzer

Characterization of loci

SWGDAM
guideline 3.1

Loci in this kit

Nature of
polymorphisms

“The basic characteristics of a genetic marker should be determined and
documented.” (SWGDAM, December 2012)

This section describes basic characteristics of the 27 Y-STR loci that are amplified with
the Yfiler Plus PCR Amplification Kit. Most of these loci have been extensively
characterized by other laboratories.

DYS392 and DYS5481 are trinucleotide repeats, DYS438 is a pentanucleotide repeat
and DYS448 is a hexanucleotide repeat. Their allele differences result from differences
in the number of repeat units 3-bp, 5-bp, and 6-bp respectively. The remaining Yfiler "
Plus PCR Amplification Kit loci are tetranucleotide short tandem repeat (STR) loci.
The length differences among alleles of these particular loci result from differences in
the number of 4-bp repeat units.

We have sequenced all the alleles in the Yfiler" Plus PCR Amplification Kit Allelic
Ladder. In addition, other groups in the scientific community have sequenced alleles
at some of these loci (Redd et al., 2002; www.cstl.nist.gov/biotech/strbase/y_strs.htm).
Among the various sources of sequence data on the loci, there is consensus on the
repeat patterns and structure of the STRs (Mulero et al., 2014; Gusmao et al., 2006).
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The Centre d'Etude du Polymorphisme Humain (CEPH) has collected DNA from
families of Utah Mormon, French Venezuelan, and Amish descent. These DNA sets
have been extensively studied all over the world and are routinely used to
characterize the mode of inheritance of various DNA loci. Each family set contains
three generations, generally including four grandparents, two parents, and several
offspring. Consequently, the CEPH family DNA sets are ideal for studying inheritance
patterns (Begovich et al., 1992).

The Yfiler" Plus PCR Amplification Kit loci have been mapped, and the location on
the Y-chromosome is known based on the nucleotide sequence of the Y-chromosome.
The Genbank accession numbers for representative sequences are: DYS19 (X77751,
AC017019), DYS385 (AC022486, Z93950), DYS389 (AC011289, AF140635), DYS390
(AC011289), DYS391 (G09613, AC011302), DYS392 (G09867, AC06152), DYS393
(G09601, AC06152), DYS437 (AC002992), DYS438 (AC002531), DYS439 (AC002992),
DYS448 (AC025227.6), DYS456 (AC010106.2), DYS458 (AC010902.4), DYS635 (G42676,
AC011751), DYS635 (G42673), DYS449 (AC051663), DYS481 (F]828747.1), DYS533
(ACO053516), DYS570 (AC012068), DYS576 (AC010104), DYS518 (F]J828760) and
DYS627 (BV208976).

Species specificity

SWGDAM
Guideline 3.2

Nonhuman
studies

84

“The ability to detect genetic information from non-targeted species (e.g., detection of
microbial DNA in a human assay) should be determined. The detection of genetic
information from non-targeted species does not necessarily invalidate the use of the
assay, but may help define the limits of the assay.” (SWGDAM, December 2012)

The Yfiler Plus PCR Amplification Kit provides the required specificity for detecting
human alleles. Species specificity testing was performed to ensure that there is no
cross-reactivity with nonhuman DNA that may be present in forensic casework
samples.

The following species were tested (in the specified amounts) using standard PCR and
capillary electrophoresis conditions for the Yfiler " Plus PCR Amplification Kit:
* Primates: gorilla, chimpanzee, and macaque (1.0 ng each)
* Non-primates: mouse, dog, pig, rat, sheep, horse, chicken, and cow (10.0 ng each)
* Microorganisms: Candida albicans, Neisseria gonorrhoeae, Escherichia coli 0157:H7,
Bacillus subtilis, Staphylococcus aureus, and Lactobacillus rhamnosus (5 ng each)

Results were evaluated for the presence of any amplified peaks that would indicate
cross reactivity of the Yfiler " Plus PCR Amplification Kit with any of these non-
human species.

The chimpanzee and gorilla DNA samples produced partial profiles in the 100-
330 base pair region.
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The remaining species tested did not yield reproducible detectable products.
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Figure 26 Representative electropherograms from a species specificity study including
positive and negative control.

“The ability to obtain reliable results from a range of DNA quantities, to include the
upper and lower limits of the assay, should be evaluated.” (SWGDAM, December
2012)

The Yfiler" Plus PCR Amplification Kit has been optimized at 25 uL PCR reaction
volume to overcome the PCR inhibition expected when amplifying:

¢ Blood samples that are obtained directly from unpurified 1.2 mm treated paper
discs

* Buccal cells that are obtained directly from unpurified 1.2 mm treated paper discs
(with the addition of Prep-n-Go " Buffer )

* Buccal swab sample lysate is prepared using Prep-n-Go'" Buffer
Depending on the following conditions, DNA quantities present on the 1.2 mm disc
may vary from laboratory to laboratory:

* Volume of blood that is spotted onto the treated paper

® Collecting devices that are used

* Collection methods that are applied

* Swab-to-paper transfer protocol that is used

It is essential to optimize the PCR conditions for types of blood samples and spotting
protocol. See “Direct amplification: Optimize PCR cycle number” on page 21.
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If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by the
instrument (“off-scale” data).

Off-scale data is a problem because:

— Quantitation (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter
peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

— Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.

™

To ensure minimal occurrence of offscale data when using the Yfiler * Plus PCR
Amplification Kit , optimize PCR cycle number according to instructions in the
Perform PCR chapter.

When the total number of allele copies added to the PCR is extremely low, unbalanced
amplification of the alleles may occur because of stochastic fluctuation.

Figure 27 shows the results of amplification of different input DNA amounts. The
optimal amount of input male DNA added to the Yfiler" Plus kit is 0.5-1.0 ng for

30 cycles of amplification when using extracted and purified DNA. The final DNA
concentration should be 0.05-0.10 ng/uL, so that 0.5-1.0 ng of male DNA is added to
the 10-uL PCR reaction. If the sample contains degraded DNA, amplification of
additional DNA can be beneficial.
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To determine an appropriate minimum peak height threshold for your instruments
and data, perform internal validation studies.
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Figure 27 Effect of amplifying 1 ng, 500 pg, 250 pg, 125 pg, 62 pg, and 31 pg of male
control DNA 007 using two voltage conditions. Data analyzed using the 3500xL Genetic
Analyzer. The Y-axis scale is 0 to 12,000 RFUs.

“The ability to obtain results from DNA recovered from biological samples deposited
on various substrates and subjected to various environmental and chemical insults
should be evaluated. In most instances, assessment of the effects of these factors on
new forensic DNA procedures is not required. However, if substrates and/or
environmental and/or chemical insults could potentially affect the analytical process,
then the process should be evaluated to determine the effects of such factors.”
(SWGDAM, December 2012)

As with any multi-locus system, the possibility exists that not every locus amplifies.
This possibility is most often observed when the DNA sample contains PCR inhibitors
or when the DNA sample has been severely degraded. Valuable information can be
obtained from partial profiles.
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Traces of humic acid can inhibit the PCR amplification of DNA evidence that is
collected from soil. Amplification of 1.0 ng of DNA Control 007 in the presence of
increasing amounts of humic acid was performed using the Yfiler " Plus kit

(Figure 28). The concentrations of humic acid tested were 0, 100, and 250 ng/uL. The
same concentrations were tested with the Yfiler" Plus kit for comparison. At

250 ng/uL, neither kit yielded amplified products.
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Figure 28 Electropherograms for the Yfiler™ Plus and AmpFESTR™ Yfiler™ kits show the
improved performance of the Yfiler™ Plus kit in the presence of humic acid compared to

the Yfiler™ kit. The Y-axis scale is 0 to 20,000 RFUs for the top two panels, 0 to 30,000 RFUs
for the third panel, and 0 to 4,000 RFUs for the bottom panel.
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Degraded DNA As the average size of degraded DNA approaches the size of the target sequence, the
amount of PCR product generated is reduced. This is due to the reduced number of
intact templates in the size range necessary for amplification.

Degraded DNA was prepared to examine the potential for preferential amplification
of loci. High molecular weight DNA was incubated with the enzyme DNase I for
varying amounts of time. The DNA was examined by agarose gel analysis to
determine the average size of the DNA fragments at each time point.

2 ng of degraded DNA (or 1 ng undegraded DNA) was amplified using the Yfiler""
Plus kit . As the DNA became increasingly degraded, the loci became undetectable
according to size. The loci failed to robustly amplify in the order of decreasing size as
the extent of degradation progressed (Figure 29).
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Figure 29 Amplification of A3121 DNA samples sonicated and incubated with increasing
doses of DNase I. Panels 1, 2, 3, and 4 correspond to 0, 4, 5, and 6 units of DNase I. Note
that the y-axis scale is magnified for more degraded samples, which generate lower peak
heights.

Mixture studies

SV\_/G D'_A‘M “The ability to obtain reliable results from mixed source samples should be
guideline 3.8 determined.” (SWGDAM, December 2012)

Male/female Evidence samples that contain body fluids and/or tissues originating from more than
mixture studies one individual are an integral component of forensic casework. Therefore it is

essential to ensure that the DNA typing system is able to detect DNA mixtures. In the
case of Y-STRs, the female DNA component is not amplified by the Y-chromosome-
specific primers. Male/female mixture studies were performed up to a ratio of 1:4,000
using three different female DNAs. The amount of female DNA was kept constant at
1 pg and the amount of male control DNA was changed. The female DNA did not
cause any interference with the interpretation of the male Y-STR profile as shown in
Figure 30.
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Mixture studies

g
)‘\ w
o,

Low-level artifacts with female DNA have been occasionally observed in the FAM™

™

(270-280 bp) and TAZ ~ (225-260 bp) dye. In general, these artifacts peaks should not
affect interpretation due to their morphology and intensity.
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Figure 30 Amplification of male Control DNA 007 in the presence of female DNA 9947A.
Profiles shown in the panels from top to bottom: 1 ng of male DNA, 1 ng male DNA with 1
pg female DNA, 500 pg male DNA with 1 pg female DNA, 250 pg male DNA with 1 ug
female DNA, 1 pg female DNA. The Y-axis scale is magnified for lower input amounts of
male DNA samples, which generate lower peak heights (Y-axis scale is 0 to 200 RFUs for
the 1-pg female input).

Male/male Forensic samples may contain body fluids or tissues originating from more than one
mixture studies male. Mixtures of two male DNA samples were examined at various ratios (1:1 to
1:15). The total amount of genomic input DNA mixed at each ratio was 1 ng.

Table 6 Haplotypes of samples in the figure that follows this table.

Locus Sample A Sample B
DYS576 15 19
DYS389I 14 13
DYS635 21 24
DYS38911 31 29
DYS627 21 21
DYS460 10 11
DYS458 17 17

DYS19 15 15

YGATAH4 12 13

DYS448 21 19

DYS391 10 11
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Locus Sample A Sample B
DYS456 13 15
DYS390 21 24
DYS438 12 12
DYS392 11 13
DYS518 38 37
DYS570 19 17
DYS437 14 15
DYS385 a/b 16,19 11, 14
DYS449 29 30
DYS393 14 13
DYS439 11 12
DYS481 27 22
DYF387S1 36,39 35,37
DYS533 11 13

A representative electropherogram of 1-ng total male/male DNA mixture studies is
shown in Figure 31. The limit of detection is when the minor component is present at
approximately one-tenth of the concentration of the major component. The limit of
detection for the minor component is influenced by the combination of genotypes in
the mixture.
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Figure 31 Mixtures of two male DNA samples (1:8 ratio, 125 pg: 875 pg) 1-ng input DNA.
The alleles attributable to the minor component, even when the major component shares
an allele, are highlighted.
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"The laboratory should establish guidelines for the number of Y-STR loci used for
searches of

population databases." (SWGDAM, January 2014)

All Y-STR loci analyzed in commercial kits are physically linked on the Y-
chromosome. Due to the lack of recombination, the entire Y-chromosome haplotype
must be treated as a single locus. Haplotype frequencies are estimated using the
counting method. The counting method involves searching a given haplotype against
a database to determine the number of times the haplotype was observed in that
database. The frequency of the haplotype in the database is then estimated by
dividing the count by the number of haplotypes searched. (SWGDAM, January 2014)

™

The Yfiler  Plus PCR Amplification Kit was used to generate the population data that
are provided in this section. Whole blood samples, provided by the Interstate Blood
Bank (Memphis, Tennessee) and Boca Biolistics (Coconut Creek, Florida), were
collected in the United States (with no geographical preference) from randomly
selected individuals of known ethnicities. Ethnicities of sample donors were:

* African-American—557 samples
e U.S. Asian—340 samples
* U.S. Caucasian—533 samples
¢ U.S. Hispanic—391 samples
DNA was extracted with a 6100 Nucleic Acid Prep Station.

™

The Yfiler " Plus PCR Amplification Kit contains loci for which extensive population
data are available.

In addition to the haplotypes that we observed and recorded in our databases, other
alleles have been published or reported to us by other laboratories (see the STRBase at
www.cstl.nist.gov/div831/strbase, see the YHARD at www.yhrd.org, and see the U.S.
Y-STR database at www.usystrdatabase.org).

Table 7 shows the Yfiler " Plus kit gene diversity in three populations, which are listed
as percentages.

Table 7 Yfiler" Plus kit Gene diversity values across four different U.S. populations

Locus :ni::‘;iac';'n U.S. Caucasian | U.S. Hispanic U.S. Asian
(n = 557) (n =533) (n=391) (n = 340)
DYS576 0.807 0.768 0.769 0.799
DYS389I 0.504 0.527 0.567 0.679
DYS635 0.716 0.646 0.713 0.786
DYS38911 0.746 0.676 0.729 0.770
DYS627 0.838 0.842 0.853 0.812
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Population data

Locus :nfg::'iacna-n U.S. Caucasian U.S. Hispanic U.S. Asian

(n = 557) (n=533) (n=391) (n =340)
DYS460 0.573 0.537 0.571 0.675
DYS458 0.750 0.766 0.800 0.820
DYS19 0.726 0.459 0.632 0.703
YGATAH4 0.590 0.585 0.580 0.606
DYS448 0.707 0.583 0.697 0.755
DYS391 0.445 0.540 0.561 0.437
DYS456 0.615 0.737 0.700 0.603
DYS390 0.646 0.684 0.656 0.699
DYS438 0.551 0.581 0.688 0.547
DYS392 0.445 0.592 0.664 0.710
DYS518 0.843 0.806 0.807 0.867
DYS570 0.806 0.738 0.799 0.820
DYS437 0.504 0.577 0.592 0.476
DYS385 a/b 0.942 0.854 0.904 0.973
DYS449 0.857 0.783 0.818 0.882
DYS393 0.587 0.363 0.442 0.662
DYS439 0.629 0.625 0.682 0.669
DYS481 0.857 0.724 0.790 0.821
DYF38751 0.941 0.874 0.913 0.945
DYS533 0.598 0.576 0.591 0.644

Gene diversity (D) =222 where n = sample size, pi = allele frequency (Johnson et al.,

2003).

In addition to the alleles that were observed and recorded in the Thermo Fisher
Scientific databases, other known alleles have been published or reported to us by
other laboratories. Some of these alleles occur at a low frequency and include several

microvariants (Furedi et al., 1999; Schoske et al., 2004).
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Discriminatory capacity of haplotypes

Table 8 shows the discriminatory capacity (DC) and the number of unique haplotypes
(UH) for each Y-STR marker combination listed. The discriminatory capacity was
determined by dividing the number of different haplotypes by the number of samples
in that population (Schoske et al., 2004). A unique haplotype is defined as one that
occurs only once in a given population. The number of unique haplotypes is usually
less than the number of different haplotypes in any given population.

Table 8 Discriminatory capacity and number of unique haplotypes for four U.S.
populations

African- . . . .
Y-STR American U.S[. C_at;gzsilan U.f. I:I|§;$]n|c L:.S._gszg]n
marker (n=557) S LIS WS
combination
DC (%) UH DC (%) UH DC (%) UH DC (%) UH
Yfiler™ 98.2 547 95.7 510 95.9 375 91.5 311

Yfiler™ Plus | 99.6 555 98.5 525 98.0 383 94.4 321

Mutation rate

The most accurate method of estimating Y-STR mutation rates is the direct
observation of transmission between father and son. A large-scale Y-STR analysis of
mutation rates was performed with 2,000 DNA-confirmed father-son pairs and
encompassed the Yfiler" Plus marker set (Ballantyne et al., 2010, 2012, and 2014).
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Table of Precision Results

Table 9 Example of precision results of seven injections of the Yfiler" Plus Allelic Ladder run on the 3130x/,

3500, and 3500xL

3130x( 3500 3500xL
—— Standard Standard Standard
deviation Mean deviation Mean deviation Mean
DYF38751
30 264.16-264.33 | 0.038-0.055 | 264.90-264.93 | 0.045-0.063 | 264.85-264.89 | 0.038-0.057
31 268.02-268.20 | 0.035-0.054 | 268.81-268.83 | 0.052-0.064 | 268.74-268.78 | 0.045-0.059
32 271.91-272.10 | 0.031-0.056 | 272.69-272.72 | 0.042-0.053 | 272.63-272.68 | 0.040-0.058
33 275.87-276.03 | 0.035-0.054 | 276.65-276.69 | 0.045-0.068 | 276.58-276.63 | 0.046-0.054
34 279.72-279.90 | 0.038-0.055 | 280.54-280.58 | 0.049-0.072 | 280.47-280.51 | 0.049-0.062
35 283.52-283.71 | 0.044-0.062 | 284.33-284.37 | 0.037-0.063 | 284.26-284.30 | 0.049-0.057
36 287.35-287.55 | 0.043-0.054 | 288.17-288.22 | 0.049-0.066 | 288.12-288.16 | 0.042-0.057
37 291.25-291.44 | 0.034-0.055 | 292.10-292.11 0.044-0.075 | 292.01-292.06 | 0.042-0.062
38 295.03-295.22 | 0.043-0.065 | 295.89-295.91 0.047-0.067 | 295.79-295.85 | 0.037-0.062
39 299.06-299.26 | 0.045-0.055 | 299.93-299.96 | 0.064-0.068 | 299.85-299.90 | 0.046-0.063
40 302.75-302.95 | 0.039-0.054 | 303.61-303.65 | 0.048-0.073 | 303.52-303.60 | 0.047-0.065
41 306.64-306.86 | 0.035-0.066 | 307.56-307.60 | 0.038-0.087 | 307.48-307.53 | 0.050-0.062
42 310.49-310.70 | 0.047-0.060 | 311.44-311.47 | 0.062-0.080 | 311.35-311.41 0.046-0.066
43 314.40-314.62 | 0.041-0.073 | 315.40-315.43 | 0.046-0.096 | 315.30-315.37 | 0.045-0.070
44 318.47-318.69 | 0.039-0.062 | 319.50-319.52 | 0.048-0.089 | 319.40-319.47 | 0.047-0.071
DYS19
9 183.90-183.94 | 0.023-0.030 | 184.04-184.06 | 0.028-0.048 | 183.99-184.01 | 0.026-0.039
10 188.07-188.11 0.022-0.036 | 188.20-188.22 | 0.026-0.035 | 188.16-188.18 | 0.026-0.040
1 192.11-192.13 | 0.026-0.036 | 192.26-192.28 | 0.026-0.040 | 192.22-192.24 | 0.025-0.037
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3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
12 196.10-196.13 | 0.018-0.039 | 196.24-196.27 | 0.032-0.046 | 196.21-196.23 | 0.032-0.041
13 200.17-200.21 | 0.019-0.034 | 200.30-200.33 | 0.029-0.046 | 200.28-200.29 | 0.037-0.043
14 204.09-204.13 | 0.020-0.036 | 204.24-204.27 | 0.027-0.038 | 204.21-204.21 | 0.029-0.037
15 208.05-208.09 | 0.018-0.028 | 208.22-208.24 | 0.029-0.043 | 208.16-208.18 | 0.027-0.038
16 212.03-212.05 | 0.023-0.032 | 212.20-212.26 | 0.015-0.053 | 212.15-212.16 | 0.024-0.046
17 216.07-216.10 | 0.023-0.032 | 216.22-216.25 | 0.016-0.052 | 216.18-216.20 | 0.029-0.044
18 220.14-220.19 | 0.020-0.034 | 220.30-220.34 | 0.033-0.046 | 220.27-220.29 | 0.020-0.043
19 224.15-224.20 | 0.024-0.035 | 224.34-224.35 | 0.040-0.058 | 224.30-224.31 | 0.036-0.047
DYS385 a/b
6 225.25-225.31 | 0.029-0.041 | 225.10-225.12 | 0.022-0.050 | 225.07-225.09 | 0.036-0.048
7 229.25-229.33 | 0.027-0.041 | 229.12-229.14 | 0.028-0.044 | 229.08-229.11 | 0.042-0.047
8 233.37-233.44 | 0.026-0.042 | 233.21-233.24 | 0.026-0.045 | 233.19-233.21 | 0.038-0.048
9 237.40-237.47 | 0.028-0.037 | 237.24-237.26 | 0.023-0.066 | 237.22-237.25 | 0.033-0.046
10 241.50-241.57 | 0.026-0.049 | 241.31-241.34 | 0.035-0.052 | 241.30-241.31 | 0.023-0.038
11 245.53-245.61 | 0.024-0.040 | 245.37-245.38 | 0.022-0.046 | 245.34-245.37 | 0.031-0.046
12 249.71-249.81 | 0.027-0.038 | 249.53-249.55 | 0.005-0.034 | 249.51-249.54 | 0.034-0.043
13 253.74-253.84 | 0.025-0.037 | 253.55-253.57 | 0.021-0.040 | 253.55-253.57 | 0.030-0.046
14 257.69-257.79 | 0.027-0.047 | 257.50-257.52 | 0.031-0.047 | 257.51-257.52 | 0.028-0.041
15 261.66-261.75 | 0.023-0.039 | 261.46-261.49 | 0.031-0.040 | 261.48-261.50 | 0.033-0.043
16 265.67-265.76 | 0.027-0.041 | 265.50-265.51 | 0.018-0.044 | 265.50-265.52 | 0.030-0.046
17 269.72-269.82 | 0.022-0.047 | 269.54-269.58 | 0.022-0.042 | 269.55-269.57 | 0.036-0.046
18 273.73-273.83 | 0.026-0.045 | 273.54-273.58 | 0.027-0.055 | 273.54-273.57 | 0.029-0.047
19 277.83-277.93 | 0.025-0.046 | 277.64-277.66 | 0.040-0.058 | 277.65-277.67 | 0.031-0.042
20 281.85-281.95 | 0.025-0.044 | 281.66-281.70 | 0.035-0.044 | 281.67-281.69 | 0.033-0.044
21 285.85-285.94 | 0.029-0.044 | 285.65-285.69 | 0.036-0.043 | 285.67-285.68 | 0.030-0.043
22 289.82-289.93 | 0.029-0.052 | 289.63-289.65 | 0.037-0.050 | 289.63-289.66 | 0.030-0.040
23 293.78-293.89 | 0.031-0.046 | 293.58-293.62 | 0.030-0.040 | 293.58-293.60 | 0.032-0.047
24 297.79-297.89 | 0.029-0.042 | 297.57-297.60 | 0.037-0.065 | 297.56-297.60 | 0.034-0.050
25 301.75-301.85 | 0.025-0.052 | 301.56-301.58 | 0.038-0.045 | 301.55-301.57 | 0.020-0.050
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3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
26 305.71-305.82 | 0.034-0.039 | 305.51-305.53 | 0.018-0.054 | 305.51-305.53 | 0.026-0.039
27 309.71-309.82 | 0.036-0.044 | 309.50-309.55 | 0.028-0.042 | 309.52-309.54 | 0.032-0.044
28 313.78-313.87 | 0.032-0.051 | 313.53-313.58 | 0.005-0.051 | 313.55-313.58 | 0.043-0.049
DYS389I
9 146.74-146.78 | 0.025-0.034 | 146.98-147.01 | 0.019-0.044 | 146.81-146.84 | 0.025-0.042
10 150.83-150.87 | 0.026-0.033 | 151.06-151.09 | 0.019-0.039 | 150.90-150.91 | 0.032-0.041
11 154.86-154.91 | 0.024-0.031 | 155.09-155.11 | 0.030-0.042 | 154.92-154.94 | 0.034-0.038
12 158.98-159.04 | 0.027-0.036 | 159.22-159.24 | 0.007-0.030 | 159.04-159.07 | 0.021-0.035
13 163.19-163.26 | 0.020-0.031 | 163.41-163.43 | 0.028-0.045 | 163.25-163.27 | 0.026-0.038
14 167.12-167.19 | 0.018-0.034 | 167.33-167.35 | 0.015-0.030 | 167.18-167.19 | 0.027-0.033
15 171.17-171.21 | 0.017-0.040 | 171.34-171.37 | 0.022-0.039 | 171.21-171.22 | 0.021-0.038
16 175.19-175.24 | 0.020-0.025 | 175.37-175.40 | 0.020-0.046 | 175.23-175.24 | 0.026-0.039
17 179.23-179.28 | 0.013-0.034 | 179.40-179.41 | 0.005-0.032 | 179.25-179.27 | 0.041-0.045
DYS389II
24 265.02-265.11 | 0.025-0.032 | 265.16-265.20 | 0.023-0.060 | 265.12-265.12 | 0.030-0.044
25 269.11-269.20 | 0.024-0.040 | 269.23-269.25 | 0.030-0.052 | 269.17-269.18 | 0.030-0.042
26 273.08-273.17 | 0.021-0.043 | 273.23-273.24 | 0.026-0.040 | 273.15-273.17 | 0.028-0.042
27 277.22-277.32 | 0.024-0.039 | 277.36-277.39 | 0.036-0.054 | 277.29-277.31 | 0.030-0.042
28 281.15-281.25 | 0.020-0.048 | 281.29-281.32 | 0.032-0.047 | 281.21-281.22 | 0.034-0.043
29 285.01-285.10 | 0.019-0.041 | 285.14-285.16 | 0.029-0.043 | 285.07-285.09 | 0.028-0.041
30 289.17-289.26 | 0.026-0.047 | 289.31-289.33 | 0.027-0.039 | 289.23-289.25 | 0.034-0.039
31 293.15-293.24 | 0.023-0.043 | 293.27-293.31 | 0.037-0.040 | 293.19-293.21 | 0.023-0.037
32 297.02-297.11 | 0.027-0.035 | 297.14-297.15 | 0.029-0.059 | 297.04-297.07 | 0.028-0.044
33 300.97-301.06 | 0.025-0.041 | 301.10-301.13 | 0.039-0.049 | 301.02-301.03 | 0.037-0.043
34 304.81-304.89 | 0.024-0.035 | 304.93-304.96 | 0.025-0.060 | 304.85-304.86 | 0.031-0.038
35 308.89-308.97 | 0.027-0.041 | 309.01-309.03 | 0.036-0.046 | 308.93-308.94 | 0.040-0.050
DYS390
17 14414-144.23 | 0.026-0.044 | 144.14-144.19 | 0.038-0.042 | 144.09-144.11 | 0.029-0.039
18 148.04-148.12 | 0.020-0.038 | 148.06-148.10 | 0.021-0.051 | 147.98-148.01 | 0.035-0.043
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3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
19 151.96-152.04 | 0.026-0.037 | 151.99-152.02 | 0.026-0.043 | 151.92-151.93 | 0.029-0.039
20 156.15-156.25 | 0.027-0.046 | 156.16-156.20 | 0.026-0.041 | 156.09-156.12 | 0.025-0.038
21 160.16-160.24 | 0.031-0.039 | 160.17-160.18 | 0.000-0.043 | 160.09-160.10 | 0.025-0.037
22 164.21-164.30 | 0.024-0.039 | 164.21-164.24 | 0.020-0.061 | 164.15-164.17 | 0.030-0.041
23 168.34-168.42 | 0.026-0.039 | 168.31-168.34 | 0.030-0.048 | 168.25-168.28 | 0.032-0.044
24 172.34-172.42 | 0.024-0.038 | 172.30-172.32 | 0.032-0.055 | 172.25-172.27 | 0.025-0.033
25 176.33-176.41 | 0.024-0.034 | 176.30-176.33 | 0.029-0.044 | 176.24-176.26 | 0.027-0.037
26 180.35-180.44 | 0.023-0.036 | 180.33-180.34 | 0.032-0.041 | 180.27-180.29 | 0.026-0.041
27 184.33-184.42 | 0.019-0.030 | 184.32-184.34 | 0.040-0.052 | 184.26-184.28 | 0.031-0.044
28 188.44-188.53 | 0.026-0.041 | 188.41-188.43 | 0.032-0.050 | 188.36-188.38 | 0.029-0.043
29 192.49-192.58 | 0.027-0.042 | 192.46-192.48 | 0.022-0.047 | 192.41-192.44 | 0.034-0.042
DYS391
5 352.78-352.85 | 0.024-0.035 | 353.42-353.45 | 0.038-0.057 | 353.34-353.36 | 0.034-0.049
6 356.84-356.91 | 0.032-0.042 | 357.46-357.51 | 0.032-0.054 | 357.39-357.42 | 0.036-0.051
7 360.69-360.78 | 0.030-0.036 | 361.40-361.43 | 0.026-0.057 | 361.32-361.35 | 0.040-0.049
8 364.75-364.85 | 0.034-0.045 | 365.47-365.49 | 0.019-0.035 | 365.40-365.43 | 0.033-0.057
9 368.74-368.85 | 0.023-0.042 | 369.47-369.50 | 0.024-0.060 | 369.39-369.43 | 0.033-0.046
10 372.75-372.87 | 0.020-0.040 | 373.47-373.48 | 0.036-0.076 | 373.40-373.44 | 0.032-0.050
11 376.75-376.87 | 0.029-0.044 | 377.47-377.47 | 0.019-0.047 | 377.38-377.42 | 0.037-0.044
12 380.81-380.90 | 0.031-0.052 | 381.44-381.48 | 0.018-0.050 | 381.36-381.39 | 0.028-0.049
13 384.93-385.02 | 0.029-0.045 | 385.56-385.60 | 0.020-0.063 | 385.47-385.50 | 0.037-0.042
14 388.98-389.07 | 0.024-0.038 | 389.60-389.62 | 0.023-0.050 | 389.50-389.54 | 0.028-0.036
15 393.02-393.08 | 0.026-0.046 | 393.63-393.67 | 0.024-0.043 | 393.55-393.57 | 0.033-0.045
16 397.05-397.12 | 0.031-0.042 | 397.66-397.70 | 0.022-0.057 | 397.58-397.61 | 0.032-0.047
DYS392
4 273.67-273.77 | 0.028-0.036 | 274.35-274.38 | 0.045-0.056 | 274.25-274.28 | 0.039-0.047
5 276.63-276.74 | 0.027-0.044 | 277.36-277.39 | 0.048-0.063 | 277.25-277.28 | 0.030-0.048
6 279.61-279.73 | 0.021-0.038 | 280.32-280.35 | 0.033-0.051 | 280.22-280.25 | 0.045-0.054
7 282.64-282.75 | 0.023-0.032 | 283.35-283.39 | 0.042-0.056 | 283.26-283.29 | 0.037-0.048
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Table of typical precision results

3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
8 285.54-285.66 | 0.026-0.030 | 286.23-286.25 | 0.050-0.065 | 286.12-286.16 | 0.032-0.048
9 288.52-288.60 | 0.027-0.036 | 289.12-289.14 | 0.040-0.057 | 289.00-289.04 | 0.034-0.044
10 291.25-291.38 | 0.026-0.040 | 291.97-292.00 | 0.049-0.065 | 291.87-291.89 | 0.034-0.052
11 294.30-294.42 | 0.026-0.039 | 295.04-295.05 | 0.051-0.072 | 294.91-294.94 | 0.030-0.055
12 297.26-297.38 | 0.026-0.038 | 297.96-297.99 | 0.036-0.058 | 297.84-297.88 | 0.035-0.058
13 300.19-300.30 | 0.031-0.045 | 300.89-300.90 | 0.037-0.067 | 300.77-300.80 | 0.038-0.047
14 303.01-303.13 | 0.027-0.036 | 303.73-303.74 | 0.048-0.061 | 303.59-303.63 | 0.036-0.050
15 306.00-306.12 | 0.028-0.040 | 306.70-306.74 | 0.043-0.070 | 306.59-306.63 | 0.033-0.052
16 309.03-309.15 | 0.026-0.044 | 309.71-309.73 | 0.041-0.073 | 309.58-309.62 | 0.038-0.053
17 311.93-312.06 | 0.027-0.044 | 312.67-312.70 | 0.027-0.064 | 312.54-312.58 | 0.027-0.047
18 314.96-315.09 | 0.029-0.040 | 315.75-315.77 | 0.019-0.060 | 315.61-315.65 | 0.042-0.051
19 318.11-318.23 | 0.022-0.035 | 318.88-318.90 | 0.028-0.056 | 318.75-318.78 | 0.035-0.047
20 321.21-321.35 | 0.022-0.039 | 321.97-322.00 | 0.049-0.063 | 321.84-321.88 | 0.027-0.058
DYS393
7 90.33-90.36 0.021-0.032 90.35-90.39 0.027-0.037 90.23-90.25 0.029-0.037
8 94.35-94.36 0.024-0.037 94.37-94.42 0.020-0.032 94.27-94.28 0.033-0.041
9 98.51-98.53 0.020-0.030 98.53-98.56 0.028-0.039 98.43-98.44 0.040-0.044
10 102.63-102.64 | 0.014-0.029 | 102.67-102.70 | 0.021-0.052 | 102.56-102.57 | 0.033-0.040
11 106.89-106.90 | 0.019-0.027 | 106.94-106.96 | 0.026-0.037 | 106.82-106.84 | 0.029-0.037
12 110.79-110.81 | 0.024-0.030 | 110.85-110.88 | 0.039-0.056 | 110.74-110.76 | 0.031-0.041
13 114.80-114.81 | 0.017-0.028 | 114.87-114.91 | 0.020-0.041 | 114.76-114.78 | 0.026-0.035
14 118.72-118.74 | 0.021-0.029 | 118.79-118.81 | 0.033-0.043 | 118.67-118.69 | 0.010-0.032
15 122.51-122.53 | 0.024-0.036 | 122.61-122.62 | 0.031-0.044 | 122.48-122.49 | 0.030-0.041
16 126.56-126.59 | 0.017-0.029 | 126.66-126.68 | 0.029-0.046 | 126.54-126.56 | 0.036-0.041
17 130.54-130.55 | 0.015-0.033 | 130.62-130.66 | 0.023-0.036 | 130.51-130.53 | 0.027-0.041
18 134.51-134.54 | 0.019-0.029 | 134.61-134.64 | 0.025-0.038 | 134.52-134.53 | 0.030-0.043
DYS437
10 177.93-177.98 | 0.027-0.035 | 178.26-178.28 | 0.031-0.053 | 178.20-178.22 | 0.030-0.047
11 181.97-182.01 | 0.026-0.036 | 182.29-182.32 | 0.030-0.045 | 182.24-182.26 | 0.040-0.046
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12 186.02-186.07 | 0.021-0.041 | 186.35-186.38 | 0.027-0.041 | 186.31-186.32 | 0.031-0.046
13 189.98-190.02 | 0.020-0.039 | 190.28-190.31 | 0.020-0.051 | 190.24-190.26 | 0.033-0.043
14 194.03-194.07 | 0.023-0.041 | 194.34-194.37 | 0.028-0.049 | 194.29-194.31 | 0.041-0.044
15 198.15-198.20 | 0.025-0.031 | 198.49-198.51 | 0.017-0.040 | 198.46-198.47 | 0.035-0.046
16 202.13-202.19 | 0.030-0.037 | 202.47-202.50 | 0.026-0.047 | 202.44-202.45 | 0.035-0.041
17 206.08-206.12 | 0.023-0.034 | 206.42-206.45 | 0.026-0.056 | 206.36-206.38 | 0.033-0.040
18 210.03-210.07 | 0.022-0.036 | 210.38-210.41 | 0.031-0.054 | 210.33-210.35 | 0.038-0.045
DYS438
6 207.14-207.22 | 0.024-0.032 | 207.69-207.73 | 0.044-0.059 | 207.67-207.68 | 0.033-0.040
7 212.16-212.22 | 0.025-0.032 | 212.70-212.71 | 0.030-0.049 | 212.66-212.68 | 0.030-0.054
8 217.23-217.31 | 0.022-0.038 | 217.78-217.82 | 0.029-0.050 | 217.76-217.77 | 0.032-0.038
9 222.32-222.41 | 0.023-0.032 | 222.87-222.90 | 0.023-0.064 | 222.86-222.87 | 0.030-0.040
10 227.38-227.47 | 0.027-0.030 | 227.91-227.94 | 0.016-0.068 | 227.90-227.93 | 0.036-0.054
11 232.43-232.52 | 0.032-0.037 | 232.96-232.98 | 0.031-0.065 | 232.95-232.98 | 0.032-0.046
12 237.48-237.58 | 0.021-0.038 | 238.03-238.04 | 0.035-0.047 | 238.00-238.03 | 0.032-0.049
13 242.64-242.71 | 0.024-0.033 | 243.14-243.17 | 0.027-0.052 | 243.14-243.16 | 0.025-0.037
14 247.82-247.87 | 0.022-0.031 | 248.30-248.32 | 0.040-0.050 | 248.28-248.31 | 0.033-0.046
15 252.87-252.90 | 0.022-0.037 | 253.31-253.33 | 0.027-0.056 | 253.31-253.34 | 0.024-0.041
16 257.80-257.85 | 0.014-0.029 | 258.24-258.26 | 0.021-0.041 | 258.24-258.27 | 0.034-0.039
DYS439
6 149.93-150.01 | 0.016-0.027 | 150.28-150.31 | 0.021-0.046 | 150.23-150.24 | 0.028-0.039
7 154.05-154.12 | 0.020-0.036 | 154.38-154.41 | 0.033-0.055 | 154.32-154.34 | 0.034-0.041
8 158.15-158.23 | 0.031-0.036 | 158.51-158.52 | 0.031-0.052 | 158.43-158.46 | 0.025-0.046
9 162.21-162.30 | 0.024-0.034 | 162.54-162.59 | 0.036-0.046 | 162.49-162.50 | 0.036-0.043
10 166.33-166.41 | 0.023-0.029 | 166.65-166.69 | 0.033-0.039 | 166.60-166.62 | 0.026-0.044
11 170.27-170.36 | 0.022-0.032 | 170.60-170.64 | 0.039-0.054 | 170.56-170.59 | 0.027-0.045
12 174.30-174.39 | 0.020-0.032 | 174.64-174.67 | 0.029-0.050 | 174.58-174.61 | 0.028-0.045
13 178.38-178.47 | 0.027-0.047 | 178.72-178.75 | 0.032-0.052 | 178.66-178.70 | 0.041-0.046
14 182.44-182.52 | 0.029-0.035 | 182.78-182.81 | 0.035-0.051 | 182.74-182.76 | 0.025-0.045
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deviation Mean deviation Mean deviation Mean
15 186.45-186.53 | 0.024-0.033 | 186.79-186.82 | 0.029-0.052 | 186.76-186.78 | 0.036-0.044
16 190.51-190.60 | 0.025-0.042 | 190.86-190.88 | 0.026-0.048 | 190.83-190.85 | 0.037-0.047
17 194.58-194.66 | 0.024-0.040 | 194.93-194.96 | 0.027-0.054 | 194.90-194.93 | 0.034-0.047
DYS448
14 277.79-277.88 | 0.032-0.045 | 278.38-278.41 | 0.033-0.059 | 278.39-278.41 | 0.040-0.063
15 283.72-283.80 | 0.021-0.044 | 284.33-284.34 | 0.030-0.065 | 284.31-284.34 | 0.034-0.048
16 289.61-289.69 | 0.033-0.043 | 290.22-290.25 | 0.031-0.062 | 290.21-290.24 | 0.031-0.050
17 295.50-295.59 | 0.031-0.045 | 296.12-296.14 | 0.039-0.060 | 296.11-296.13 | 0.039-0.059
18 301.34-301.43 | 0.036-0.043 | 301.98-302.00 | 0.040-0.061 | 301.95-302.00 | 0.040-0.066
19 307.17-307.28 | 0.035-0.043 | 307.85-307.88 | 0.042-0.061 | 307.83-307.87 | 0.037-0.050
20 313.18-313.29 | 0.038-0.048 | 313.87-313.91 | 0.051-0.079 | 313.86-313.90 | 0.040-0.060
21 319.33-319.45 | 0.036-0.049 | 320.06-320.09 | 0.035-0.052 | 320.06-320.10 | 0.039-0.066
22 325.50-325.63 | 0.041-0.053 | 326.21-326.23 | 0.038-0.062 | 326.22-326.26 | 0.049-0.060
23 331.46-331.61 | 0.036-0.056 | 332.16-332.19 | 0.039-0.070 | 332.16-332.20 | 0.045-0.066
24 337.39-337.53 | 0.038-0.051 | 338.10-338.14 | 0.024-0.077 | 338.11-338.15 | 0.040-0.060
DYS449
22 325.50-325.57 | 0.027-0.062 | 325.58-325.61 | 0.037-0.049 | 325.63-325.67 | 0.035-0.049
23 329.59-329.64 | 0.027-0.064 | 329.65-329.67 | 0.028-0.054 | 329.71-329.73 | 0.039-0.060
24 333.63-333.66 | 0.025-0.062 | 333.66-333.72 | 0.025-0.041 | 333.75-333.76 | 0.032-0.045
25 337.66-337.69 | 0.031-0.058 | 337.68-337.72 | 0.033-0.045 | 337.76-337.78 | 0.027-0.040
26 341.69-341.75 | 0.029-0.052 | 341.72-341.77 | 0.025-0.042 | 341.79-341.81 | 0.039-0.051
27 345.76-345.87 | 0.029-0.050 | 345.80-345.84 | 0.031-0.049 | 345.87-345.88 | 0.032-0.043
28 349.82-349.93 | 0.028-0.061 | 349.87-349.89 | 0.018-0.051 | 349.93-349.94 | 0.029-0.039
29 353.87-353.98 | 0.025-0.053 | 353.92-353.95 | 0.020-0.060 | 353.98-353.99 | 0.034-0.044
30 357.92-358.03 | 0.028-0.060 | 357.97-358.00 | 0.027-0.042 | 358.03-358.06 | 0.035-0.050
31 361.97-362.04 | 0.036-0.045 | 362.01-362.04 | 0.021-0.040 | 362.07-362.09 | 0.032-0.059
32 365.98-366.06 | 0.034-0.042 | 366.01-366.04 | 0.038-0.055 | 366.08-366.10 | 0.035-0.041
33 369.99-370.07 | 0.029-0.042 | 370.00-370.04 | 0.038-0.048 | 370.08-370.11 | 0.030-0.047
34 373.99-374.09 | 0.025-0.044 | 374.02-374.04 | 0.027-0.061 | 374.09-374.12 | 0.033-0.053
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35 377.99-378.08 | 0.032-0.047 | 378.01-378.06 | 0.040-0.055 | 378.10-378.11 | 0.039-0.047
36 382.03-382.12 | 0.034-0.043 | 382.03-382.08 | 0.027-0.053 | 382.12-382.13 | 0.031-0.051
37 386.08-386.18 | 0.022-0.043 | 386.09-386.12 | 0.025-0.045 | 386.17-386.19 | 0.034-0.048
38 390.12-390.22 | 0.020-0.042 | 390.14-390.16 | 0.025-0.044 | 390.21-390.23 | 0.036-0.044
39 394.14-394.28 | 0.030-0.043 | 394.18-394.20 | 0.029-0.049 | 394.24-394.26 | 0.037-0.043
40 398.17-398.31 | 0.029-0.053 | 398.21-398.25 | 0.024-0.047 | 398.27-398.29 | 0.030-0.038
DYS456
10 76.25-76.30 0.033-0.043 76.25-76.28 0.044-0.050 76.08-76.10 0.031-0.042
11 80.51-80.56 0.016-0.036 80.54-80.56 0.025-0.047 80.40-80.42 0.026-0.037
12 84.72-84.78 0.023-0.035 84.74-84.77 0.009-0.043 84.63-84.64 0.028-0.035
13 88.92-88.97 0.020-0.036 88.95-88.99 0.021-0.035 88.84-88.85 0.024-0.036
14 93.11-93.16 0.022-0.036 93.13-93.17 0.024-0.047 93.03-93.05 0.028-0.039
15 97.28-97.34 0.024-0.037 97.30-97.35 0.027-0.038 97.23-97.24 0.021-0.035
16 101.47-101.53 | 0.022-0.031 | 101.52-101.55 | 0.010-0.033 | 101.42-101.43 | 0.034-0.040
17 105.65-105.72 | 0.021-0.030 | 105.73-105.75 | 0.025-0.038 | 105.62-105.64 | 0.023-0.035
18 109.81-109.88 | 0.022-0.037 | 109.89-109.92 | 0.023-0.056 | 109.77-109.80 | 0.027-0.038
19 113.92-113.98 | 0.029-0.032 | 114.01-114.04 | 0.028-0.060 | 113.89-113.91 | 0.032-0.038
20 117.90-117.95 | 0.022-0.035 | 118.01-118.02 | 0.026-0.044 | 117.88-117.88 | 0.022-0.029
21 121.86-121.93 | 0.022-0.036 | 121.97-122.01 | 0.040-0.044 | 121.84-121.86 | 0.036-0.042
22 125.85-125.93 | 0.027-0.033 | 125.98-126.00 | 0.032-0.048 | 125.85-125.87 | 0.032-0.038
23 129.87-129.94 | 0.029-0.033 | 130.00-130.04 | 0.042-0.058 | 129.88-129.89 | 0.032-0.040
24 133.89-133.96 | 0.026-0.033 | 134.04-134.05 | 0.030-0.041 | 133.92-133.94 | 0.024-0.044
DYS458
11 119.84-119.98 | 0.027-0.034 | 120.25-120.28 | 0.039-0.065 | 120.11-120.13 | 0.039-0.041
12 123.66-123.81 | 0.026-0.038 | 124.10-124.13 | 0.042-0.056 | 123.96-123.98 | 0.026-0.040
13 127.52-127.66 | 0.025-0.041 | 127.97-128.01 | 0.035-0.053 | 127.82-127.85 | 0.027-0.040
14 131.37-131.53 | 0.033-0.038 | 131.84-131.90 | 0.040-0.069 | 131.70-131.74 | 0.024-0.041
15 135.26-135.41 | 0.020-0.043 | 135.77-135.80 | 0.035-0.059 | 135.62-135.65 | 0.030-0.038
16 139.17-139.32 | 0.027-0.046 | 139.68-139.72 | 0.041-0.051 | 139.56-139.58 | 0.028-0.044

102

Yiler"™ Plus PCR Amplification Kit User Guide




Appendix A Table of Precision Results
Table of typical precision results

3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
17 143.06-143.24 | 0.030-0.044 | 143.61-143.64 | 0.028-0.049 | 143.47-143.52 | 0.030-0.040
18 147.14-147.31 | 0.030-0.045 | 147.70-147.72 | 0.033-0.054 | 147.56-147.59 | 0.035-0.047
19 151.22-151.39 | 0.029-0.050 | 151.77-151.83 | 0.040-0.060 | 151.65-151.68 | 0.034-0.043
20 155.22-155.39 | 0.028-0.047 | 155.79-155.82 | 0.031-0.062 | 155.65-155.68 | 0.029-0.049
21 159.12-159.30 | 0.028-0.049 | 159.71-159.73 | 0.028-0.041 | 159.57-159.61 | 0.027-0.042
22 163.07-163.26 | 0.027-0.050 | 163.65-163.69 | 0.039-0.063 | 163.52-163.55 | 0.035-0.048
23 166.99-167.18 | 0.019-0.060 | 167.58-167.61 | 0.028-0.059 | 167.45-167.48 | 0.030-0.042
24 170.92-171.11 | 0.028-0.064 | 171.52-171.54 | 0.042-0.063 | 171.38-171.42 | 0.033-0.044
DYS460
7 79.58-79.61 0.031-0.038 79.58-79.60 0.053-0.060 79.38-79.40 0.023-0.039
8 83.76-83.80 0.021-0.040 83.75-83.78 0.042-0.058 83.58-83.460 0.026-0.037
9 87.96-87.98 0.025-0.037 87.92-87.97 0.027-0.035 87.77-87.79 0.029-0.038
10 92.12-92.15 0.024-0.042 92.10-92.13 0.023-0.043 91.95-91.97 0.031-0.044
11 96.29-96.31 0.028-0.041 96.26-96.30 0.030-0.049 96.11-96.13 0.030-0.040
12 100.46-100.48 | 0.023-0.045 | 100.44-100.48 | 0.039-0.048 | 100.28-100.30 | 0.034-0.042
13 104.65-104.67 | 0.028-0.035 | 104.64-104.67 | 0.030-0.038 | 104.48-104.50 | 0.025-0.039
14 108.80-108.84 | 0.028-0.039 | 108.79-108.82 | 0.025-0.040 | 108.63-108.66 | 0.027-0.033
DYS481
17 206.82-206.84 | 0.018-0.034 | 206.89-206.93 | 0.023-0.040 | 206.96-206.97 | 0.025-0.038
18 209.80-209.81 | 0.018-0.032 | 209.86-209.88 | 0.027-0.044 | 209.92-209.93 | 0.030-0.036
19 212.76-212.78 | 0.026-0.036 | 212.86-212.87 | 0.009-0.050 | 212.89-212.91 | 0.037-0.045
20 215.78-215.80 | 0.021-0.035 | 215.86-215.88 | 0.016-0.042 | 215.91-215.94 | 0.027-0.042
21 218.85-218.87 | 0.018-0.033 | 218.91-218.94 | 0.010-0.032 | 218.98-218.99 | 0.029-0.040
22 221.88-221.90 | 0.024-0.039 | 221.93-221.96 | 0.020-0.042 | 222.00-222.02 | 0.038-0.048
23 224.88-224.90 | 0.023-0.033 | 224.94-224.97 | 0.025-0.037 | 225.02-225.03 | 0.039-0.049
24 227.88-227.90 | 0.021-0.032 | 227.95-227.97 | 0.037-0.055 | 228.03-228.04 | 0.037-0.043
25 230.90-230.92 | 0.017-0.034 | 230.96-230.99 | 0.035-0.054 | 231.03-231.04 | 0.030-0.049
26 233.91-233.93 | 0.022-0.033 | 233.97-233.98 | 0.027-0.049 | 234.04-234.06 | 0.032-0.042
27 236.91-236.93 | 0.018-0.034 | 236.98-237.00 | 0.023-0.053 | 237.06-237.07 | 0.033-0.037
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28 239.94-239.95 | 0.023-0.033 | 239.99-240.01 | 0.000-0.048 | 240.07-240.08 | 0.026-0.048
29 243.03-243.05 | 0.023-0.031 | 243.08-243.10 | 0.026-0.046 | 243.15-243.16 | 0.030-0.034
30 246.11-246.13 | 0.023-0.031 | 246.14-246.16 | 0.025-0.052 | 246.21-246.23 | 0.029-0.040
31 249.17-249.21 | 0.023-0.032 | 249.18-249.21 | 0.009-0.038 | 249.27-249.28 | 0.030-0.038
32 252.15-252.20 | 0.025-0.033 | 252.19-252.20 | 0.020-0.045 | 252.27-252.28 | 0.029-0.039
DYS518
32 332.35-332.38 | 0.025-0.054 | 332.32-332.35 | 0.027-0.045 | 332.32-332.35 | 0.038-0.046
33 336.40-336.41 | 0.029-0.050 | 336.35-336.38 | 0.024-0.045 | 336.36-336.39 | 0.030-0.050
34 340.43-340.48 | 0.026-0.047 | 340.36-340.40 | 0.005-0.044 | 340.39-340.41 | 0.005-0.041
35 344.52-344.59 | 0.025-0.051 | 344.45-344.49 | 0.032-0.051 | 344.48-344.50 | 0.035-0.052
36 348.60-348.70 | 0.024-0.047 | 348.54-348.57 | 0.011-0.044 | 348.56-348.59 | 0.027-0.042
37 352.67-352.76 | 0.025-0.059 | 352.60-352.64 | 0.033-0.053 | 352.63-352.65 | 0.029-0.042
38 356.74-356.82 | 0.026-0.054 | 356.69-356.71 | 0.038-0.049 | 356.70-356.73 | 0.038-0.054
39 360.82-360.88 | 0.025-0.044 | 360.73-360.77 | 0.036-0.049 | 360.77-360.79 | 0.035-0.058
40 364.83-364.91 | 0.021-0.043 | 364.76-364.78 | 0.026-0.046 | 364.80-364.82 | 0.030-0.041
41 368.87-368.92 | 0.021-0.036 | 368.78-368.80 | 0.032-0.059 | 368.82-368.84 | 0.035-0.046
42 372.87-372.94 | 0.030-0.038 | 372.78-372.83 | 0.033-0.043 | 372.83-372.85 | 0.030-0.041
43 376.91-376.98 | 0.026-0.043 | 376.81-376.83 | 0.026-0.057 | 376.84-376.88 | 0.038-0.053
44 380.95-381.01 | 0.024-0.034 | 380.83-380.86 | 0.041-0.052 | 380.88-380.89 | 0.030-0.049
45 385.00-385.07 | 0.024-0.038 | 384.89-384.92 | 0.019-0.045 | 384.93-384.95 | 0.029-0.046
46 389.05-389.14 | 0.027-0.035 | 388.96-388.97 | 0.026-0.054 | 388.99-389.00 | 0.038-0.048
47 393.09-393.19 | 0.023-0.043 | 393.00-393.02 | 0.033-0.049 | 393.04-393.06 | 0.025-0.053
48 397.12-397.24 | 0.034-0.047 | 397.04-397.08 | 0.028-0.054 | 397.08-397.12 | 0.031-0.052
49 401.16-401.26 | 0.025-0.039 | 401.08-401.10 | 0.018-0.041 | 401.10-401.13 | 0.031-0.051
DYS533
7 338.37-338.42 | 0.028-0.035 | 338.61-338.63 | 0.036-0.049 | 338.55-338.56 | 0.020-0.036
8 342.44-342.48 | 0.024-0.040 | 342.64-342.69 | 0.027-0.043 | 342.61-342.62 | 0.040-0.046
9 346.54-346.56 | 0.026-0.038 | 346.72-346.77 | 0.028-0.044 | 346.68-346.70 | 0.032-0.047
10 350.61-350.63 | 0.026-0.039 | 350.82-350.85 | 0.026-0.053 | 350.75-350.76 | 0.033-0.048
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Appendix A Table of Precision Results
Table of typical precision results

3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
11 354.68-354.69 | 0.024-0.035 | 354.87-354.91 | 0.024-0.037 | 354.81-354.83 | 0.028-0.051
12 358.73-358.77 | 0.026-0.035 | 358.93-358.97 | 0.015-0.059 | 358.88-358.90 | 0.029-0.046
13 362.76-362.78 | 0.023-0.035 | 362.96-362.99 | 0.018-0.043 | 362.90-362.93 | 0.028-0.045
14 366.76-366.79 | 0.021-0.035 | 366.95-366.99 | 0.029-0.048 | 366.92-366.95 | 0.034-0.043
15 370.78-370.82 | 0.022-0.029 | 370.99-371.01 | 0.032-0.064 | 370.94-370.97 | 0.031-0.048
16 374.79-374.82 | 0.033-0.034 | 374.99-375.02 | 0.030-0.047 | 374.93-374.96 | 0.035-0.047
17 378.80-378.83 | 0.025-0.039 | 379.01-379.03 | 0.010-0.045 | 378.94-378.97 | 0.041-0.049
DYS570
10 97.99-98.02 0.021-0.034 98.02-98.04 0.026-0.044 97.95-97.96 0.035-0.043
11 102.12-102.15 | 0.024-0.034 | 102.13-102.16 | 0.023-0.041 | 102.08-102.09 | 0.028-0.034
12 106.23-106.27 | 0.021-0.029 | 106.26-106.29 | 0.032-0.046 | 106.20-106.21 | 0.026-0.036
13 110.33-110.35 | 0.022-0.033 | 110.35-110.37 | 0.032-0.044 | 110.28-110.30 | 0.028-0.043
14 114.36-114.38 | 0.018-0.030 | 114.40-114.41 | 0.024-0.038 | 114.32-114.34 | 0.017-0.037
15 118.29-118.32 | 0.021-0.030 | 118.32-118.34 | 0.022-0.037 | 118.23-118.25 | 0.035-0.038
16 122.21-122.24 | 0.023-0.041 | 122.23-122.26 | 0.032-0.041 | 122.15-122.17 | 0.027-0.036
17 126.18-126.21 | 0.026-0.041 | 126.21-126.22 | 0.030-0.042 | 126.13-126.14 | 0.027-0.042
18 130.16-130.19 | 0.021-0.041 | 130.18-130.20 | 0.015-0.039 | 130.11-130.12 | 0.028-0.034
19 134.15-134.19 | 0.027-0.038 | 134.18-134.21 | 0.025-0.038 | 134.11-134.13 | 0.026-0.041
20 138.19-138.23 | 0.026-0.043 | 138.20-138.25 | 0.027-0.046 | 138.14-138.16 | 0.027-0.036
21 142.27-142.30 | 0.024-0.033 | 142.29-142.31 | 0.024-0.037 | 142.23-142.25 | 0.034-0.040
22 146.38-146.42 | 0.021-0.028 | 146.39-146.42 | 0.020-0.033 | 146.34-146.35 | 0.028-0.038
23 150.50-150.55 | 0.027-0.031 | 150.49-150.51 | 0.035-0.046 | 150.45-150.47 | 0.025-0.039
24 154.62-154.67 | 0.023-0.040 | 154.61-154.64 | 0.027-0.039 | 154.57-154.60 | 0.027-0.036
25 158.75-158.81 | 0.024-0.038 | 158.73-158.75 | 0.034-0.038 | 158.69-158.70 | 0.016-0.029
26 162.84-162.88 | 0.027-0.042 | 162.80-162.82 | 0.019-0.042 | 162.76-162.79 | 0.031-0.040
DYS576
10 72.26-72.37 0.028-0.050 72.79-72.82 0.041-0.073 72.45-72.47 0.038-0.045
11 76.42-76.55 0.027-0.043 77.02-77.03 0.059-0.066 76.69-76.71 0.028-0.047
12 80.56-80.68 0.020-0.038 81.18-81.20 0.039-0.064 80.88-80.89 0.036-0.040
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Appendix A Table of Precision Results
Table of typical precision results

3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
13 84.65-84.77 0.021-0.033 85.27-85.30 0.040-0.052 84.98-85.01 0.031-0.037
14 88.71-88.86 0.029-0.041 89.35-89.38 0.040-0.068 89.07-89.10 0.029-0.040
15 92.79-92.93 0.026-0.043 93.42-93.47 0.039-0.057 93.17-93.19 0.024-0.040
16 96.84-96.99 0.029-0.039 97.49-97.54 0.041-0.055 97.24-97.26 0.029-0.040
17 100.90-101.05 | 0.021-0.045 | 101.59-101.63 | 0.027-0.051 | 101.34-101.35 | 0.038-0.039
18 104.98-105.14 | 0.029-0.040 | 105.69-105.72 | 0.038-0.069 | 105.41-105.44 | 0.026-0.037
19 109.02-109.19 | 0.026-0.053 | 109.73-109.77 | 0.033-0.071 | 109.47-109.49 | 0.025-0.043
20 113.02-113.20 | 0.025-0.050 | 113.76-113.79 | 0.037-0.080 | 113.49-113.50 | 0.034-0.040
21 116.93-117.09 | 0.029-0.042 | 117.65-117.67 | 0.033-0.065 | 117.38-117.40 | 0.031-0.040
22 120.77-120.95 | 0.025-0.042 | 121.51-121.54 | 0.042-0.074 | 121.23-121.27 | 0.026-0.041
23 124.66-124.83 | 0.029-0.042 | 125.43-125.46 | 0.041-0.081 | 125.14-125.17 | 0.030-0.039
24 128.56-128.74 | 0.030-0.050 | 129.36-129.38 | 0.062-0.069 | 129.07-129.09 | 0.028-0.040
25 132.47-132.66 | 0.025-0.042 | 133.28-133.32 | 0.035-0.072 | 132.99-133.04 | 0.029-0.036
DYS627
11 323.89-324.05 | 0.049-0.059 | 325.01-325.03 | 0.048-0.094 | 324.93-324.98 | 0.052-0.066
12 327.79-327.94 | 0.043-0.066 | 328.92-328.97 | 0.038-0.095 | 328.84-328.89 | 0.058-0.074
13 331.66-331.84 | 0.033-0.053 | 332.81-332.85 | 0.053-0.080 | 332.73-332.77 | 0.048-0.070
14 335.53-335.71 | 0.046-0.062 | 336.67-336.72 | 0.045-0.086 | 336.61-336.65 | 0.055-0.063
15 339.38-339.53 | 0.040-0.056 | 340.53-340.57 | 0.054-0.086 | 340.45-340.50 | 0.044-0.070
16 343.29-343.42 | 0.040-0.055 | 344.42-344.47 | 0.025-0.103 | 344.35-344.42 | 0.048-0.056
17 347.21-347.32 | 0.040-0.060 | 348.36-348.40 | 0.050-0.101 | 348.28-348.33 | 0.047-0.059
18 351.11-351.22 | 0.037-0.061 | 352.27-352.31 | 0.052-0.097 | 352.19-352.24 | 0.050-0.071
19 355.07-355.22 | 0.047-0.062 | 356.26-356.29 | 0.050-0.098 | 356.17-356.23 | 0.046-0.063
20 358.90-359.06 | 0.047-0.060 | 360.11-360.17 | 0.048-0.114 | 360.02-360.10 | 0.053-0.072
21 362.69-362.85 | 0.038-0.064 | 363.92-363.94 | 0.059-0.092 | 363.83-363.90 | 0.053-0.066
22 366.53-366.69 | 0.049-0.070 | 367.77-367.80 | 0.040-0.095 | 367.69-367.75 | 0.051-0.067
23 370.36-370.53 | 0.045-0.064 | 371.62-371.66 | 0.044-0.075 | 371.53-371.61 | 0.054-0.064
24 374.21-374.37 | 0.054-0.069 | 375.47-375.52 | 0.074-0.077 | 375.39-375.46 | 0.062-0.070
25 378.05-378.21 | 0.059-0.074 | 379.32-379.36 | 0.055-0.067 | 379.23-379.32 | 0.058-0.067
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Appendix A Table of Precision Results
Table of typical precision results

3130x( 3500 3500xL
Allete Standard Standard Standard
deviation Mean deviation Mean deviation Mean
26 381.90-382.06 | 0.062-0.080 | 383.22-383.27 | 0.059-0.086 | 383.12-383.20 | 0.056-0.074
27 385.79-385.94 | 0.064-0.079 | 387.10-387.14 | 0.069-0.094 | 387.02-387.10 | 0.046-0.073
DYS635
15 191.34-191.39 | 0.026-0.034 | 191.90-191.92 | 0.036-0.052 | 191.76-191.77 | 0.034-0.046
16 195.40-195.44 | 0.024-0.038 | 195.95-195.98 | 0.030-0.049 | 195.82-195.83 | 0.033-0.047
17 199.45-199.49 | 0.025-0.036 | 200.00-200.01 | 0.000-0.056 | 199.87-199.88 | 0.042-0.046
18 203.42-203.46 | 0.020-0.036 | 203.96-203.98 | 0.021-0.048 | 203.82-203.83 | 0.031-0.044
19 207.37-207.41 | 0.021-0.038 | 207.92-207.94 | 0.022-0.040 | 207.77-207.79 | 0.030-0.040
20 211.35-211.38 | 0.027-0.036 | 211.89-211.91 | 0.017-0.060 | 211.75-211.77 | 0.034-0.041
21 215.41-215.44 | 0.022-0.034 | 215.96-215.99 | 0.016-0.059 | 215.82-215.83 | 0.030-0.052
22 219.43-219.48 | 0.027-0.039 | 219.99-220.01 | 0.000-0.048 | 219.85-219.87 | 0.045-0.046
23 223.44-223.49 | 0.023-0.037 | 224.00-224.02 | 0.033-0.061 | 223.86-223.89 | 0.038-0.053
24 227.31-227.38 | 0.024-0.036 | 227.88-227.92 | 0.034-0.051 | 227.76-227.77 | 0.034-0.043
25 231.45-231.52 | 0.023-0.036 | 232.03-232.06 | 0.034-0.064 | 231.91-231.93 | 0.037-0.050
26 235.35-235.42 | 0.021-0.030 | 235.93-235.95 | 0.039-0.053 | 235.81-235.84 | 0.032-0.042
27 239.49-239.55 | 0.032-0.036 | 240.07-240.09 | 0.000-0.058 | 239.95-239.97 | 0.043-0.046
28 243.60-243.65 | 0.026-0.038 | 244.17-244.19 | 0.023-0.035 | 244.05-244.09 | 0.031-0.048
29 247.70-247.75 | 0.022-0.032 | 248.24-248.27 | 0.017-0.039 | 248.14-248.17 | 0.038-0.046
30 251.73-251.77 | 0.021-0.037 | 252.25-252.29 | 0.020-0.052 | 252.14-252.18 | 0.032-0.045
YGATAH4
8 235.91-235.96 | 0.022-0.032 | 236.18-236.22 | 0.031-0.055 | 236.15-236.16 | 0.030-0.047
9 239.92-239.96 | 0.023-0.036 | 240.19-240.22 | 0.031-0.065 | 240.16-240.18 | 0.028-0.055
10 244.04-244.09 | 0.023-0.030 | 244.31-244.34 | 0.033-0.047 | 244.27-244.28 | 0.030-0.046
11 248.14-248.15 | 0.018-0.033 | 248.39-248.41 | 0.041-0.052 | 248.35-248.36 | 0.032-0.047
12 252.15-252.17 | 0.020-0.034 | 252.37-252.39 | 0.020-0.040 | 252.35-252.37 | 0.031-0.040
13 256.07-256.10 | 0.024-0.039 | 256.31-256.33 | 0.029-0.039 | 256.28-256.30 | 0.027-0.042
14 259.97-260.00 | 0.015-0.032 | 260.24-260.27 | 0.000-0.049 | 260.19-260.23 | 0.032-0.047
15 263.94-263.99 | 0.019-0.042 | 264.22-264.25 | 0.019-0.040 | 264.20-264.22 | 0.034-0.045
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Troubleshooting

Observation

Possible cause

Recommended action

Faint or no signal from both the
DNA Control 007 and the DNA
test samples at all loci

The incorrect volume of Master
Mix or Primer Set was used.

Use the correct volume of Master Mix or
Primer Set.

The DNA Polymerase was not
activated.

Repeat the amplification with an initial hold at
95°C for 1 minute.

The Master Mix was not
vortexed thoroughly before
aliquoting.

Vortex the Master Mix thoroughly.

The Primer Set was exposed to
too much light.

Replace the Primer Set and store it protected
from light.

Evaporation.

Ensure that the plate is properly sealed with
film and that a compression pad was used with
the GeneAmp™ PCR System 9700. (A
compression pad should not be used with other
validated thermal cyclers.)

The thermal cycler
malfunctioned.

See the thermal cycler user manual and check
the instrument calibration.

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.

A MicroAmp™ base was used
with a tray/retainer set and
tubes in GeneAmp™ PCR
System 9700.

Remove the MicroAmp™ base.

The tubes or plate were not
seated tightly in the thermal
cycler during amplification.

Push the tubes or plate firmly into the block
after first cycle.

The wrong PCR reaction tubes
or plate were used.

Use MicroAmp™ Reaction Tubes with Caps or
the MicroAmp™ Optical 96-well Reaction Plate
for the GeneAmp™ PCR System 9700 or Veriti™
Thermal Cycler.

Insufficient PCR product was
electrokinetically injected.

Use correct genetic analyzer settings.

Degraded formamide was used.

Check the storage of formamide. Do not thaw
and refreeze multiple times. Try Hi-Di™
Formamide.

Positive signal from DNA
Control 007 but partial or no
signal from DNA test samples

The quantity of test DNA
sample is below the assay
sensitivity.

Quantify DNA and (when possible) add 1.0 ng of
DNA. For low concentration samples, add up to
15 pL of the DNA sample to the reaction mix,
or consider using the 30-cycle protocol.

The test sample contains a high
concentration of PCR inhibitor
(for example, heme

Quantify the DNA, then use the minimum
necessary volume of test sample DNA.
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Appendix B Troubleshooting
Table of typical precision results

Observation

Possible cause

Recommended action

Positive signal from DNA
Control 007 but partial or no
signal from DNA test samples

compounds, certain dyes).

Wash the sample in a Centricon™-100
centrifugal filter unit.

The test sample DNA is
severely degraded.

Use the Quantifiler™ HP DNA Quantification Kit
or the Quantifiler™ Trio DNA Quantification Kit
to evaluate sample quality during the
quantification step. If DNA is degraded,
reamplify with an increased amount of DNA or
use the AmpFESTR™ MiniFiler™ PCR
Amplification Kit.

The test sample was diluted in
the wrong buffer (for example,
a TE buffer with an incorrect
EDTA concentration).

Redilute DNA using low-TE buffer (with 0.1 mM
EDTA).

More than two alleles present
at a locus

Secondary gene duplication at
DYS385 a/b, and/or DYF387S1.

Some samples may exhibit uneven peak height
ratios at these markers due to either the
stochastic effects of the PCR or a secondary
duplication event in one of the alleles. We
recommend that allele calls be made based on
peaks that are present (conservative approach)
unless additional evidence is gathered to
conclusively demonstrate that a secondary
duplication event has taken place.

Exogenous DNA is present in
the sample.

Use appropriate techniques to avoid
introducing foreign DNA during laboratory
handling.

Stutter product (-1 repeat unit
position) was amplified.

Interpret the results according to your
laboratory procedure.

See Chapter 5, “Experiments and results”

The test sample contained
mixed DNA.

Interpret the results according to your
laboratory procedure.

See Chapter 5, “Experiments and results”

Incomplete 3" A base addition
(n-1 nt position) occured.

Include the final extension step of 60°C for
22 minutes in the PCR.

The signal exceeds the dynamic
range of the instrument and is
causing signal “pull-up” into
adjacent channels.

Ensure the cycle number is optimized. Use
fewer PCR cycles or interpret the off-scale
data according to your laboratory procedure.

Check that you are using the recommended
number of PCR cycles. Repeat PCR
amplification using reduced input DNA amount,
or interpret the off-scale data according to
your laboratory procedure.
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Appendix B Troubleshooting
Table of typical precision results

Observation

Possible cause

Recommended action

More than two alleles present
at a locus

3130 instruments: Depending on instrument
sensitivity, DNA input amounts 21 ng amplified
at 29 cycles can demonstrate off-scale peak
heights for homozygous peaks. For more
information, go to thermofisher.com, then
search for the technical note Evaluation of a
decreased cycle number (28 cycles] and
decreased injection time (5 seconds] when the
GlobalFiler" PCR Amplification Kit is run on a
3130 xl Genetic Analyzer, or contact your local
Human ldentification representative.

Poor spectral separation
occurred.

Perform a spectral calibration.

Confirm that Filter Set J6 modules are
installed and used for analysis.

Too much DNA was present in
the reaction.

Use recommended amount of template DNA
(1.0 ng).

The double-stranded DNA was
not completely denatured.

Use the recommended amount of Hi-Di™
Formamide and heat the sample plate at 95°C
for 3 minutes.

Some but not all loci visible on
electropherogram of DNA Test
Samples

The punched disc you used was
too large.

Use a 1.2 mm disc.

Insufficient lysis of the swab
head occurred.

Ensure the swab heads are incubated for
20 minutes in 400 pL of Prep-n-Go™ Buffer.

The PCR reaction volume you
used is lower than the volume
required for the amplification.

Use the correct PCR reaction volume: 15 pL

STR profiles contain many off-
scale alleles

The PCR cycle number used
was too high.

Perform a sensitivity experiment to determine
the optimal PCR cycle number based on the
sample type.

Blood samples: Too much liquid
blood was spotted onto the
paper substrate.

Spot <100 pL of liquid blood per sample area.

Poor peak height balance

Incorrect thermal cycler
conditions were used.

Use correct thermal cycler conditions.
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Materials required but not supplied

STRIKIt ..o 111
Sample preparation required materials ........... ... ... . i 111
Thermal cycler required materials ........... ... ... ... ... ... L. 113
Genetic analyzer required materials ............ ... ... ... ... L. 114
Analysis software required materials .......... ... ... .. o ool 115
Miscellaneous required materials ............ ... ... ... . L. 115

Unless otherwise indicated, all materials are available through thermofisher.com.
MLS: Fisher Scientific (fisherscientific.com) or other major laboratory supplier.

STR kit

Item Source
Yfiler™ Plus PCR Amplification Kit, 100-reaction kit 4484678
Yfiler™ Plus PCR Amplification Kit, 500-reaction kit 4482730
GeneScan -600 LIZ"™ Size Standard v2.0, 2 x 200 pL 4408399

IMPORTANT! Do not use GeneScan' 350 ROX", GeneScan " 500 ROX ", or
GeneScan™ 500 LIZ™ Size Standards with this kit.

Hi-Di™ Formamide, 25-mL 4311320

Sample preparation required materials

Treated paper substrate

Item Source
Collection system:
Whatman™ FTA™ Classic Cards MLS
Whatman™ EasiCollect™ system MLS
Sample preparation:
Prep-n-Go" Buffer (for use with untreated paper substrates) 4467079
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Appendix C Materials required but not supplied
Sample preparation required materials

Item

Source

Low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0)

Teknova T0223

Punch tool:

Harris Micro-Punch™ tool, 1.2-mm

MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a
1.2-mm punch head

BSD1000-GenePunch Automated Dried Sample Punch Instrument with a
1.2-mm punch head

Contact your local sales office.

Untreated paper substrate

Item Source
Collection system:
903 paper MLS
Punch tool:
Harris Micro-Punch™ tool, 1.2-mm MLS

BSD600-Duet Semi-Automated Dried Sample Punch Instrument with a
1.2-mm punch head

BSD1000-GenePunch Automated Dried Sample Punch Instrument with a
1.2-mm punch head

Contact your local sales office.

Swab substrate

Item Source
Collection system
4N6FLOQSwabs™, regular tip 4473979
Sample preparation:
Prep-n-Go " Buffer (for use with buccal swab substrates) 4471406
Heated lysis protocol only: 1.5 mL tube format or 96-well deep-well plate format
1.5 mL tube format
1.5 mL tubes MLS
Oven VWR™ Scientific dry heat block or

equivalent

96-well deep-well plate format
PrepFiler™ 96-Well Processing Plates 4392904
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Appendix C Materials required but not supplied
Thermal cycler required materials

Item

Source

Robbins Scientific” Model 400 Hybridization Incubator or equivalent MLS

Agilent™ Benchtop Rack for 200 pL Tubes/V Bottom Plates (metal) or

equivalent

IMPORTANT! Do not use a plastic plate adaptor.

Agilent Technologies 410094

Thermal cycler required materials

ProFlex” PCR System

Item Source
ProFlex™ 96-well PCR System 4484075
ProFlex™ 3 x 32-Well PCR System 4484073
Veriti" Thermal Cycler
Item Source
Veriti" 96-Well Thermal Cycler 4479071
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
GeneAmp' PCR System 9700
Item Source
GeneAmpw PCR System 9700, 96-Well Silver N8050001
GeneAmp" PCR System 9700, 96-Well Gold-Plated 4314878
Silver 96-Well Sample Block N8050251
Gold-Plated 96-Well Block 4314443
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Appendix C Materials required but not supplied
Genetic analyzer required materials

Genetic analyzer required materials

3500 Series Genetic Analyzer

Item Source
3500/3500xL Data Collection Software v3 (RUO) A26287 1]
3500/3500xL Data Collection Software v2 (RUO) 447518312
HID Updater 3500 Data Collection Software v2 4480670
Anode buffer container (ABC] 4393927
Cathode buffer container (CBC] 4408256
POP-4" Polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393710
POP-4" Polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393715
DS-36 Matrix Standard Kit (Dye Set J6) 4425042
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 44612614
Septa Cathode Buffer Container, 3500 series 4410715
1" Contact your Thermo Fisher Scientific HID representative.
(21 Contact your Thermo Fisher Scientific HID representative.
3130 Series Genetic Analyzer
Item Source

3130 Data Collection Software v4 4475105
3130x{ Data Collection Software-v4 4475126
3130/3730 Data Collection Software-v4 6-Dye Module v1 4480670
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130 x/ Genetic Analyzer Capillary Array, 36-cm 4315931
POP-4" Polymer for 3130/3130 x/Genetic Analyzers 4352755
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Appendix C Materials required but not supplied
Analysis software required materials

Item Source
Running Buffer, 10X 402824
DS-36 Matrix Standard Kit (Dye Set Jé) 4425042
MicroAmp™ Optical 96-Well Reaction Plate N8010560

Analysis software required materials

GeneMapper™ /D-X Software

Item Source
GeneMapper" /D-X Software v1.5 Full Installation A27884
GeneMapper " /D-XSoftware v1.5 Client Installation A27886
GeneMapper" /D-XSoftware v1.4 Full Installation 4479707
GeneMapper ™ /D-X Software v1.4 Client Installation 4479711

Miscellaneous required materials

Plates and tubes

Item Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp™ Optical 8-Cap Strips 4323032
MicroAmp" 96-Well Tray/Retainer Set 403081
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
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Appendix C Materials required but not supplied
Miscellaneous required materials

Laboratory supplies

Item Source
Various procedures
Aerosol resistant pipette tips MLs
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon”™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

0 Major laboratory supplier
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Example PCR plate layout

Plate layouts

The following layout is recommended for use with the sensitivity experiment in the
Perform PCR chapter. Create 3 identical plates for amplification at 3 different cycle

numbers.
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Example electrophoresis plate layout

The following layout is recommended for use with the sensitivity experiment in the

Perform PCR chapter.
1 2 3 4 ] B 7 8 9 10 M 12
A Samp1 | Samp8 | Samp 15 | Samp 22 | Samp 1 | Samp8 | Samp 15| Samp 22 [ Samp 1| Sampl | Samp 15 Samp &2
B SampZ2 | SampQ | Samp 15 | Samp 23 | Samp Z | SampQ | Samp 16| Samp 23 |iSamp 2 | Samp gl Samp 1G] Samp 23
[ Samp32 [ Samp 10| Samp 17 | Samp 24 | Samp 2 | Samp 10 | Samp 17 | Samp 24 | Samp 3 | Samp 10 | Samp 17 | Samp 29
[} Samp< | Samp 11 | Samp 18 | Samp 256 | Samp 4 | Samp 11 | Samp 18 | Samp 25 | Samp <[ Samp | Samp 18 Samp 25
E SampS | Samp1Z| Samp 19 | Samp 25 | Samp 5 | Samp 12 | Samp 19| Samp 25 |iSamp S| Samp 12 Samp 19 Samp 25
F Sampb | Samp 13| Samp 20 | NHeg ctrl | Samp 6 | Samp 13 | Samp 20| Meg ol [ Samp G [ Samp 13 Samp 20 Heg ol
[&] Samp?7 | Samp 14| Samp 21 ooy Samp ¥ | Samp 14 | Samp 21 oo7 Samp 7| Sampdd | Samp 2 aodF
H Allelic CE Allelic CE Allelic CE Allelic CE Allatic CE Allelic CE
Ladder Blank Ladder Blark Ladder Blank Ladder Blark Ladder Blank Ladder Blark
[ | | I [ |
Cycle 1 Cycle 2 Cycle 3
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PCR work areas

Work area setupand labdesign .............. ... ... .o ool 118
PCR setup work area materials ........... ... ... .. i L 118
Amplified DNA workarea .......... ..ot 119

Work area setup and lab design

Many resources are available for the appropriate design of a PCR laboratory. If you
are using this kit for:

* Forensic DNA testing, see "Forensic Laboratories: Handbook for Facility
Planning, Design, Construction, and Moving", National Institute of Justice, 1998

e Parentage DNA testing, see the "Guidance for Standards for Parentage
Relationship Testing Laboratories", American Association of Blood Banks, 7th
edition, 2004

The sensitivity of this kit (and other PCR-based tests) enables amplification of minute
quantities of DNA, necessitating precautions to avoid contamination of samples yet to
be amplified (Kwok and Higuchi, 1989).

Process samples carefully to prevent contamination by human DNA. Wear gloves at
all times and change them frequently. Close sample tubes when not in use. Limit
aerosol dispersal by handling sample tubes and reagents carefully.

Note: We do not intend these references for laboratory design to constitute all
precautions and care necessary for using PCR technology.

PCR setup work area materials

118

IMPORTANT! Do not remove these items from the PCR Setup Work Area.

¢ Calculator

* Gloves, disposable

* Marker pen, permanent
* Microcentrifuge

* Microcentrifuge tubes, 1.5-mL, or 2.0-mL, or other appropriate nuclease-free tube
(for master mix preparation)

* Microcentrifuge tube rack
* Pipette tips, sterile, disposable hydrophobic filter-plugged
¢ Pipettors
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Appendix E PCR work areas
Amplified DNA work area

* Tube decapper, autoclavable

e Vortex

Amplified DNA work area

IMPORTANT! Place the thermal cyclers in the Amplified DNA Work
Area.

Use only the validated thermal cyclers listed in “Instruments and software
compatibility” on page 15 .
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Safety

A WARNING! GENERAL SAFETY. Using this product in a manner not specified
in the user documentation may result in personal injury or damage to the
instrument or device. Ensure that anyone using this product has received
instructions in general safety practices for laboratories and the safety
information provided in this document.

- Before using an instrument or device, read and understand the safety
information provided in the user documentation provided by the
manufacturer of the instrument or device.

- Before handling chemicals, read and understand all applicable Safety Data
Sheets (SDSs) and use appropriate personal protective equipment (gloves,
gowns, eye protection, and so on). To obtain SDSs, see the “Documentation
and Support” section in this document.
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Appendix F Safety
Chemical safety

Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards,
ensure laboratory personnel read and practice the general safety guidelines for
chemical usage, storage, and waste provided below. Consult the relevant SDS
for specific precautions and instructions:

- Read and understand the Safety Data Sheets (SDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals
or hazardous materials. To obtain SDSs, see the “Documentation and
Support” section in this document.

- Minimize contact with chemicals. Wear appropriate personal protective
equipment when handling chemicals (for example, safety glasses, gloves, or
protective clothing).

- Minimize the inhalation of chemicals. Do not leave chemical containers open.
Use only with adequate ventilation (for example, fume hood).

- Check regularly for chemical leaks or spills. If a leak or spill occurs, follow
the manufacturer's cleanup procedures as recommended in the SDS.

- Handle chemical wastes in a fume hood.

- Ensure use of primary and secondary waste containers. (A primary waste
container holds the immediate waste. A secondary container contains spills
or leaks from the primary container. Both containers must be compatible
with the waste material and meet federal, state, and local requirements for
container storage.)

- After emptying a waste container, seal it with the cap provided.

- Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

- Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

- IMPORTANT! Radioactive or biohazardous materials may require special
handling, and disposal limitations may apply.
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Appendix F Safety
Biological hazard safety

Biological hazard safety

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,
infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities
with the appropriate safety equipment (for example, physical containment
devices). Safety equipment can also include items for personal protection, such
as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety
glasses, or goggles. Individuals should be trained according to applicable
regulatory and company/ institution requirements before working with
potentially biohazardous materials. Follow all applicable local, state/provincial,
and/or national regulations. The following references provide general
guidelines when handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological
and Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC)
21-1112, Revised December 2009; found at:
www.cdc.gov/biosafety/publications/bmbl5/BMBL.pdf

- World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LYO/2004.11; found at:

www.who.int/cst/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document title Pub. No.
STR kits
Yfiler" Plus PCR Amplification Kit -PCR Setup - Treated and Untreated Paper Substrates Quick 100030920
Reference
Yfiler" Plus PCR Amplification Kit - PCR Setup - Extracted DNA Quick Reference 100030921
Yfiler" Plus PCR Amplification Kit - PCR Setup - Swab Substrate Quick Reference 100030922
Yfiler" Plus PCR Amplification Kit -PCR Amplification and CE Quick Reference 100030923
Thermal cyclers
ProFlex" PCR System User Guide MAN0007697
Veriti" Thermal Cycler User Guide 4375799
GeneAmp" PCR System 9700 Base Module User Manual 4303481
3500 Series Genetic Analyzer
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software v1 User Guide 4401661
3500/3500xL. Genetic Analyzer with 3500 Series Data Collection Software v2 User Guide 4476988
HID Updater 3500 Data Collection Software v2.0 User Bulletin NA
3500/3500xL Genetic Analyzer with 3500 Series Data Collection Software 3.1 User Guide 100025036
3500 Series Data Collection Software v3 User Bulletin: New Features and HID Validation MANO0010812
Summary
3500 Series Data Collection Software v3.1 User Bulletin: New Features and HID Validation MANO0014110
Summary
3130 Series Genetic Analyzer
3130/3130x! Genetic Analyzers Maintenance, Troubleshooting, and Reference Guide 4352716
3130/3130x!( Genetic Analyzers Using Data Collection Software v3.0 User Bulletin 4363787
3130/3130x! Genetic Analyzers Getting Started Guide 4352715
3130/3130xl Genetic Analyzers Quick Reference Card 4362825
3130/3130x! Genetic Analyzers AB Navigator Software Administrator Guide 4359472
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Documentation and support
Related documentation

Document title Pub. No.

GeneMapper ™ /D-XSoftware all versions

GeneMapper" ID-X Software Bin Overlap User Bulletin 100029546

GeneMapper" /D-XSoftware v1.0

GeneMapper" ID-X Software v1.0 Getting Started Guide— Basic Features 4375574
GeneMapper" ID-X Software v1.0 Quick Reference— Basic Features 4375670
GeneMapper" ID-X Software v1.0 Installation Guide 4476603
GeneMapper" ID-X Software v1.0 Administrator Guide 4376327
GeneMapper" ID-X Software v1.0 Reference Guide 4375671

GeneMapper" /D-XSoftware v1.1

GeneMapper" ID-X Software v1.1 Getting Started Guide— Mixture Analysis Tool 4396773

GeneMapper™ /D-XSoftware v1.2

GeneMapper" ID-X Software v1.2 Verification Experiments and Installation Procedures User 4462639
Bulletin

GeneMapperm /D-X Software v1.2 Quick Reference— Mixture Analysis Tool 4426482
GeneMapper" ID-X Software v1.2 Reference Guide 4426481

GeneMapper" /D-XSoftware v1.3

GeneMapper" ID-X Software v1.3 Verification Experiments and Installation Procedures User 4470483
Bulletin

GeneMapper" /D-XSoftware v1.4

GeneMapper" ID-X Software v1.4 New Features and Installation Procedures User Bulletin 44T7684

GeneMapper' /D-XSoftware v1.5

GeneMapper" ID-X Software v1.5 New Features and Verification User Bulletin 100031708
GeneMapper" ID-X Software v1.5 Getting Started Guide— Basic Features 100031701
GeneMapper" ID-X Software v1.5 Quick Reference— Basic Features 100031702
GeneMapper" ID-X Software v1.5 Getting Started Guide— Mixture Analysis Tool 100031704
GeneMapper" ID-X Software v1.5 Quick Reference— Mixture Analysis Tool 100031705
GeneMapper" ID-X Software v1.5 Installation Guide 100031706
GeneMapper" ID-X Software v1.5 Administrator Guide 100031703
GeneMapper" ID-X Software v1.5 Reference Guide 100031707
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Documentation and support
Customer and technical support

Customer and technical support

For support:

¢ In North America—Send an email to HIDTechSupport@thermofisher.com, or
call 888-821-4443 option 1.

* Outside North America—Contact your local support office.
For the latest services and support information for all locations, go to
thermofisher.com/support to obtain the following information.

* Worldwide contact telephone numbers

* Product support

¢ Order and web support

e Safety Data Sheets (SDSs; also known as MSDSs)

Additional product documentation, including user guides and Certificates of
Analysis, are available by contacting Customer Support.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth
in the Life Technologies' General Terms and Conditions of Sale at
www.thermofisher.com/us/en/home/global/terms-and-conditions.html. If you have
any questions, please contact Life Technologies at www.thermofisher.com/support.
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